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All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in 
any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 
written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for use 
with this EPSON printer. EPSON is not responsible for any use of this information as applied to other printers.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or third 
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, 
or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the 
U.S.) failure to strictly comply with SEIKO EPSON CORPORATION’s operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the use of any options 
or any consumable products other than those designated as Original EPSON Products or EPSON Approved 
Products by SEIKO EPSON CORPORATION.

EPSON and EPSON ESC/P are registered trademarks and EPSON ESC/P 2 and EPSON Stylus are trademarks of 
SEIKO EPSON CORPORATION.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of 
their respective owners. EPSON disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.

Copyright © 1996 by Epson America, Inc. 4006678
11/96
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FCC Compliance Statement
For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio or television reception. 
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does 
cause interference to radio and television reception, which can be determined by turning the equipment off and 
on, the user is encouraged to try to correct the interference by one or more of the following measures.

◗ Reorient or relocate the receiving antenna. 

◗ Increase the separation between the equipment and receiver.

◗ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

◗ Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC 
Certification of this device and may cause interference levels which exceed the limits established by the FCC for 
this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this 
device. If this equipment has more than one interface connector, do not leave cables connected to unused 
interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to 
operate the equipment.

For Canadian Users

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le materiel brouilleur du 
Canada.
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Your EPSON® Stylus™ COLOR 800 printer is the ideal output 
device for business graphics, single-page layout proofs, digital 
photography—or any project you create on your computer. 
With resolutions up to 1440 by 720 dpi, you get amazingly 
realistic photographic images and vivid graphics in color, or 
razor-sharp black printing at speeds up to eight pages per 
minute.

The printer software for Windows® and Macintosh® provides 
advanced color management, with adjustable levels of 
brightness, contrast, saturation, and ink colors. Support for 
ColorSync™ 2.01 and Windows ICM ensures printouts that 
match the colors on your monitor.

With standard parallel and serial ports and simple network 
connectivity, setting up your printer is fast and easy. EPSON’s 
specially formulated ink cartridges and wide variety of ink jet 
papers offer the most flexibility for getting the results you want. 

Introduction
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Windows System Requirements 
To use your printer and its software with a PC, your system 
should have:

◗ An IBM® compatible PC with at least a 386/25 MHz or 
faster processor

◗ Microsoft® Windows 3.1, Windows for Workgroups™ 3.1, 
or Windows 95

◗ At least 8MB of RAM (more for Windows 95)

◗ At least 20MB of free hard disk space for storing images 
(40MB or more is recommended)

◗ VGA, Super VGA, or better display adapter and monitor

◗ A shielded, twisted-pair parallel cable (6 to 10 feet long) to 
connect your computer to the printer; the cable must have 
a D-SUB, 25-pin, male connector for your computer and a 
36-pin, Centronics® compatible connector for the printer.

Macintosh System Requirements
To use your printer and its software with a Macintosh, your 
system should have:

◗ Any Macintosh or Power Macintosh model except the 
Macintosh +, Macintosh 512, Macintosh Classic, 
Macintosh SE, or PowerBook™ 100

◗ System 7.1 or later

◗ At least 8MB of RAM (16MB or more is recommended)

◗ At least 20MB of free hard disk space for storing images 
(40MB or more is recommended)

◗ VGA (8 bit, 640 × 480) or better display and monitor

◗ Standard Apple® System Peripheral-8 cable or equivalent 
(RS-422, 8-pin mini DIN male/male, Belkin F2V024 
recommended)
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How To Use Your Manuals 
To set up your printer, see the Quick Setup card. For color 
printing tips, see the Print It in EPSON Color booklet. This 
User’s Guide contains the following information:

Chapter 1 covers the basics of printing with Windows or  
Macintosh.

Chapter 2 gives guidelines for selecting the right paper or other 
media for your print job and instructions for loading it in your 
printer.

Chapter 3 tells you how to print special projects with custom 
settings for print quality and color management.

Chapter 4 explains how to manage print jobs, check printer 
status, and set up your system for network printing.

Chapter 5 gives instructions for replacing ink cartridges, 
cleaning and aligning the print heads, and cleaning and 
transporting the printer.

Chapter 6 provides solutions for any problems you may have.

Appendix A tells you how to install optional interface cards in 
your printer.

Appendix B provides the technical details on your printer, ink 
cartridges, and EPSON media.

A Glossary and Index are included at the end of the book.
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Warnings, Cautions, and Notes

You’ll find this information throughout your manual:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your 
equipment.

Notes contain important information about your printer.

Tips contain additional hints for great printing.

Where To Get Help
EPSON provides customer support and service through a 
network of authorized EPSON Customer Care Centers. Dial 
(800) 922-8911 for the nearest location or the following 
services:

◗ Fax-on-Demand access to EPSON’s technical information 
library 

◗ Literature on current and new products

◗ The location of your nearest Authorized EPSON Reseller or 
Customer Care Center 

◗ Technical information on the installation, configuration, 
and operation of EPSON products

◗ Customer relations
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For answers to commonly asked questions about EPSON 
products 24 hours a day, seven days a week, call EPSON Sound 
Advice at (800) 442-2110.

You can purchase ink cartridges, paper, manuals, accessories, 
and parts from EPSON Accessories at (800) 873-7766 (U.S. 
sales only). In Canada, please call (800) 873-7766 for dealer 
referral.

If you need help using software with an EPSON product, see the 
documentation for that program for technical support 
information.

Electronic Support Services

You can access helpful tips, specifications, DIP switch or 
jumper settings, drivers, FAQs, sample files, application notes, 
and EPSON product bulletins 24 hours a day, seven days a 
week, using a modem and one of the online services below.

World Wide Web 

From the Internet, you can reach EPSON’s Home Page at 
http://www.epson.com. 

EPSON Internet FTP Site

If you have Internet FTP capability, use your Web browser (or 
other software for FTP downloading) to log onto 
ftp.epson.com with the user name anonymous and your 
e-mail address as the password.

EPSON Download Service

You can call the EPSON Download Service at (800) 442-2007. 
Set your communications software to 8 data bits, 1 stop bit, no 
parity. Modem speed can be up to 28.8 Kbps. 
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EPSON Fax-on-Demand service

You can access EPSON’s technical information library by calling 
(800) 442-2110 or (800) 922-8911 and selecting the 
appropriate phone option. You must provide a return fax 
number to use Fax-on-Demand.

EPSON Forum on CompuServe 

Members of CompuServe® can type GO EPSON at the menu 
prompt to reach CompuServe’s Epson America Forum. As an 
owner of an EPSON product, you are eligible for a free 
introductory CompuServe membership, which entitles you to 
an introductory credit and your own user ID and password. 
To take advantage of this offer in the U.S. or Canada, call 
(800) 848-8199 and ask for representative #529. 

ENERGY STAR Compliance 
As an ENERGY STAR Partner, EPSON has determined that this 
product meets the ENERGY STAR guidelines for energy 
efficiency. The EPA ENERGY STAR Office Equipment 
program is a voluntary partnership with the computer and 
office equipment industry to promote the introduction of 
energy-efficient personal computers, monitors, printers, fax 
machines, and copiers in an effort to reduce air pollution caused 
by power generation. 
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Energy-saving Tips

Here are a few tips you can use to be even more energy-wise:

◗ If your monitor isn’t Energy Star compliant, turn it off 
when you’re not using it.

◗ Turn off your computer, printer, and monitor each day 
when you are done using them.

◗ Use the print preview option in your software so you can 
catch errors before you print something.

◗ Send e-mail rather than distributing memos. Not only is 
this faster, but you’ll save paper and storage space too.

Important Safety Instructions
Before using your printer, read the following safety instructions 
to make sure you use the printer safely and effectively:

◗ Turn off and unplug the printer before cleaning. Clean 
with a damp cloth only. Do not spill liquid on the printer.

◗ Do not place the printer on an unstable surface or near a 
radiator or heating vent.

◗ Do not block or cover the openings in the printer’s cabinet 
or insert objects through the slots.

◗ Use only the type of power source indicated on the printer’s 
label.

◗ Connect all equipment to properly grounded power 
outlets. Avoid using outlets on the same circuit as 
photocopiers or air control systems that regularly switch 
on and off.

◗ Place the printer near a wall outlet where the plug can be 
easily unplugged.

Placez l’imprimante près d’une prise de contacte où la fiche 
peut être débranchée facilement.

Caution:
Always turn the printer 
off using the P power 
button. If you’re using a 
power strip, do not 
switch it off or unplug the 
printer until the P power 
light is off.
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◗ Do not let the power cord become damaged or frayed.

◗ If you use an extension cord with the printer, make sure 
the total ampere rating of the devices plugged into the 
extension cord does not exceed the cord’s ampere rating. 
Also, make sure the total of all devices plugged into the wall 
outlet does not exceed 15 amperes.

◗ Except as specifically explained in this User’s Guide, do not 
attempt to service the printer yourself.

◗ Unplug the printer and refer servicing to qualified service 
personnel under the following conditions: 

If the power cord or plug is damaged; if liquid has entered 
the printer; if the printer has been dropped or the cabinet 
damaged; if the printer does not operate normally or 
exhibits a distinct change in performance. Adjust only those 
controls that are covered by the operating instructions.
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It’s easy to print all your color and black and white documents 
with your new EPSON Stylus COLOR 800. First you have to set 
up your printer and install the software, following the 
instructions on the Quick Setup card. Then read this chapter to 
find out about the following:

◗ Printing from Windows

◗ Printing from a Macintosh

◗ What to do when the printer lights flash

Printing from Windows
When you want to print from your Windows application, you 
click the print icon or choose Print from the File menu. You 
can then choose which pages to print, the number of copies, 
and other options. The settings that describe your print job—
whether you want to use color or black ink, for example—are 
part of your printer driver software. 

The following sections tell you how to set printer options from 
Windows applications, how to change the default printer 
settings, and how to check your printer’s status.

Basic Printing

Note:
If you’re using 
Windows NT, you’ll need 
special software for your 
printer. Contact EPSON as 
described in the 
Introduction if you need 
printer driver software for 
Windows NT.
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Setting Printer Options from Windows 
Applications

This section describes the settings you’ll need to check for all 
your everyday printouts. See Chapter 3 for information about 
advanced settings for special print jobs. 

Follow these steps to check printer settings from your word 
processor or other Windows software:

1. Click the Print icon or choose Print or Print Setup from 
the File menu. You see a printing dialog box.

2. Make sure your EPSON Stylus COLOR 800 printer is 
selected, and then click the Printer, Setup, Properties, or 
Options button. (You may have to click a combination of 
these buttons.) You see a dialog box like the following:

3. Click the Main tab if necessary and make sure the Mode 
option is set to Automatic. This is the easiest way to get 
good printing results for all kinds of documents, on all 
types of paper.

Click to see 
list of media 
types.

Click for 
more 
information.

For more information 
about printer settings, 
click the Help button. In 
Windows 95, you can 
right-click any item on the 
screen and then click 
What’s This?
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4. Choose the Media Type you want to print on from the 
following list:

◗ Plain paper

◗ 360 dpi Ink Jet Paper

◗ Photo Quality Ink Jet Paper

◗ Photo Quality Glossy Paper

◗ Photo Quality Glossy Film

◗ Ink Jet Transparencies

The type of paper or other media you choose determines 
the print quality or resolution you can use. 

See Chapter 2 for guidelines on choosing paper and 
handling special media.

5. Choose Color or Black ink.

6. Set the slider to Quality or Speed. This lets you choose 
between the fastest printing or the highest resolution for the 
media you’re using. (The slider is not available for certain 
media types.)

7. If necessary, click the Paper tab and choose your paper size, 
number of copies, and orientation. If your software 
application lets you control these settings, you don’t need 
to use the Paper tab. 

8. Click OK when you’re finished checking your settings. The 
dialog box closes.

If you’re using Windows 95, you can click Apply and keep 
the dialog box open.

9. In the printing dialog box, click Close, OK, or Print. You 
may need to click a combination of these buttons. 

While your document is printing, the EPSON Despooler 
dialog box appears, showing the printing progress and the 
status of your printer. If you’re using Windows 95, this box 
also displays the Status Monitor. (See “Checking Printer 
Status,” on page 1-5 for more information.)

For printing at the highest 
resolution (SuperFine 
quality at 1440 dpi), you 
need to use one of the 
photo quality media. For 
the best printing at any 
resolution, always use 
EPSON media.
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Setting Default Printer Options

When you change printer settings through your software 
application, the settings apply only to the application you’re 
using. If you want to adjust the default settings for all your 
Windows applications, you can access the dialog box through 
the Windows 95 Settings option or the Windows 3.1 Control 
Panel. 

Make sure all your software applications are closed before you 
start. If not, you’ll have to close and then reopen them to have 
the new default settings take effect.

Setting Default Options in Windows 95

Follow these steps: 

1. Click Start, point to Settings, and then point to Printers. 

2. Right-click the EPSON Stylus COLOR 800 icon. 

3. Select Properties. Then click the Main tab. 

You see the Main printer settings dialog box, as shown on 
page 1-2. Any changes you make will become the default 
settings for all your applications and documents. 

Setting Default Options in Windows 3.1 

Follow these steps: 

1. Double-click the Control Panel icon in the Main group. 

2. Double-click the Printers icon. 

3. Select EPSON Stylus COLOR 800 from the list of printers 
and click Setup. 

You see the Main printer settings dialog box, as shown on 
page 1-2. Any changes you make will become the default 
settings for all your applications and documents. 
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Checking Printer Status

While your document is printing, the EPSON Despooler dialog 
box appears in the lower right corner of your screen:

This dialog box shows the progress of your print job and the 
status of your printer. If you run out of paper while printing, for 
example, the Despooler warns you. You can use the buttons to 
cancel, pause, or restart your print job. 

The Status Monitor at the bottom of the dialog box shows how 
much ink is left in your printer, along with these status icons:

The name of the 
file you’re printing 
appears here.Click to pause 

printing.

Click to 
cancel printing.

Click to restart 
printing.

Note:
The Status Monitor 
appears only if you’re 
using Windows 95 and 
you’re not printing over a 
network.

The Status Monitor is checking printer status.

An error has occured. Check your printer or see Chapter 6. 

Your printer is ready to print.

Your printer is printing.

The ink level is low or empty. Check the B or A light on the 
control panel and replace the cartridge if necessary.
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Printing from a Macintosh
When you set up a new printer for your Macintosh, you need to 
check the page setup for documents in each application you use. 
You can then click the print icon or choose Print from the File 
menu. You see a dialog box that lets you choose which pages to 
print, the number of copies, and other options. The settings 
that describe your print job—whether you want to use color or 
black ink, for example—are part of your printer driver software. 

This section describes the settings you’ll need to check for all 
your everyday printouts. See Chapter 3 for information about 
advanced settings for special print jobs. 

Follow these steps to check printer settings from your word 
processor or other Macintosh software:

1. Choose Page Setup from the File menu. You see the Page 
Setup dialog box.

2. Choose your paper size and other page setup options and 
click OK. For more information about special paper 
settings, see page 2-9. 

3. Choose Print from the File menu or click the Print icon in 
your application. You see a dialog box like the following:

Click for more information 
about printer settings.

Click to see list 
of media types.
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4. Choose the number of copies and indicate which pages you 
want to print.

5. Make sure the Mode option is set to Automatic. This is 
the easiest way to get good printing results for all kinds of 
documents, on all types of paper.

6. Choose the Media Type you want to print on from the 
following list:

◗ Plain paper

◗ 360 dpi Ink Jet Paper 

◗ Photo Quality Ink Jet Paper

◗ Photo Quality Glossy Paper

◗ Photo Quality Glossy Film

◗ Ink Jet Transparencies

The type of paper or other media you choose determines 
the print quality or resolution you can use. 

See Chapter 2 for guidelines on choosing paper and 
instructions on handling special media.

7. Choose Color or Black ink.

8. Set the slider to Quality or Speed. This lets you choose 
between the fastest printing or the highest resolution for the 
media you’re using. 

9. Click Print when you’re finished checking your settings. 

If you chose background printing when you set up your 
printer, you can continue working while your document is 
printing. 

For printing at the highest 
resolution (SuperFine 
quality at 1440 dpi), you 
need to use one of the 
photo quality media. For 
the best printing at any 
resolution, always use 
EPSON media.

Note:
On the Macintosh, printer 
settings are saved with 
your document, but you 
can’t save them from one 
application to another. 
You’ll have to check your 
settings each time you 
open a new application. If 
you want to reuse 
settings, you can create 
document templates for 
your favorite applications.
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What To Do When the Printer 
Lights Flash

The four lights on your printer’s control panel show the 
printer’s status and alert you to problems like paper jams. 

power button

load/eject button
color cleaning 
button

black cleaning 
button

paper out light

color ink out light
black ink out light

power light

S When the paper light flashes, paper is jammed in the printer. 
Turn off the printer and gently pull out all jammed paper. 
Then press the E load/eject button. See page 6-14 for more 
information.

S When the paper light comes on, your paper ran out or is 
incorrectly loaded. Load paper in the feeder and then press 
the E load/eject button. 

B A When an ink light flashes, your ink supply is low. Make sure 
you have a replacement cartridge.

B A When an ink light comes on, you need to replace the ink 
cartridge. See Chapter 5 for instructions.

P When the power light flashes, the printer is receiving a print 
job or performing a maintenance operation.

P S B A When two or more lights flash, your printer may have a 
problem. See page 6-9 and page 6-10 for more information.
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Your EPSON Stylus COLOR 800 lets you print on just about 
any kind of paper you want to use. You can get great results 
printing on various sizes of plain paper, letterhead, and 
envelopes. You’ll get even better results with specially coated 
ink jet paper. For the best output, use EPSON’s photo-quality 
media: paper, glossy paper, and glossy film. 

For special projects, you can use a variety of EPSON media 
designed for ink jet printers, ranging from transparencies to 
iron-on transfer paper. You can even set up your printer to use 
custom paper sizes to print large posters and banners. This 
chapter covers the following:

◗ Using special paper and media

◗ Creating banners and other custom-size projects

Using Special Paper and Media
When you print on special media, you need to be careful about 
choosing the correct Media Type and Paper Size settings in 
your printer software. The table on the following page lists the 
available EPSON media and the Media Type setting to choose 
for each one.

Printing on
Special Media
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To order EPSON papers and other media, contact your dealer 
or call EPSON Accessories at (800) 873-7766 (U.S. sales only). 
In Canada, call (800) 873-7766 for dealer referral. 

The type of paper or other media you use is one of the most 
important factors in determining the quality of your printed 
output. For example, you can achieve the highest resolution 
(SuperFine quality at 1440 dpi) only when you use EPSON 
Photo Quality media. The following tips will help you get the 
best results on any type of paper or other media.

EPSON ink jet media and their settings

Media name Size Part number Media Type setting

EPSON 360 dpi Ink Jet Paper A4 
Letter

S041059
S041060

360 dpi Ink Jet Paper

EPSON Special Coated Paper 
for 360 dpi Printing

Letter S041060

EPSON High Quality Ink Jet 
Paper

Letter S041111 Photo Quality 
Ink Jet Paper

EPSON Photo Quality Ink Jet 
Paper

A4
Letter
Legal

S041061
S041062
S041067

EPSON Photo Quality Glossy 
Paper

A4
Letter

S041126
S041124

Photo Quality Glossy 
Paper

EPSON Photo Quality Glossy 
Film

A4
Letter

S041071
S041072

Photo Quality Glossy 
Film

EPSON High Quality Glossy 
Paper

Letter S041072

EPSON Iron-On Transfer Paper Letter S041001, S041002

EPSON Ink Jet Transparencies A4
Letter

S041063
S041064

Ink Jet Transparencies

EPSON Photo Quality Ink Jet 
Cards

4.1 × 5.8 (A6)
5 × 8
8 × 10

S041054
S041121
S041122

Photo Quality Ink Jet 
Paper

EPSON 720 dpi Index Card 4.1 × 5.8 (A6) S041054

EPSON Photo Quality Self 
Adhesive Sheets

A4 S041106

easch2.fm5  Page 2  Tuesday, January 14, 1997  9:49 AM



Printing on Special Media

2-3

Letterhead, Preprinted Forms, and Legal-size 
Paper

Load the top edge first. When you load legal-size paper, pull up 
the paper support extension as shown below:

EPSON 360 dpi High Quality and Photo 
Quality Ink Jet Paper

You can load paper up to the arrow mark on the left edge guide. 
If you use legal-size ink jet paper, don’t load it more than half 
way to the arrow mark.

EPSON Photo Quality Glossy Paper, Film, 
and Transparencies

Before you load glossy media or transparencies, put a support 
sheet (packed with the media) or a plain paper sheet beneath the 
stack. You can load up to 20 sheets of glossy paper, and up to 
30 sheets of glossy film or transparencies. 

Note:
When you load paper, 
make sure the printable 
side is facing up. Some 
special media have a cut 
corner that you need to 
position correctly; follow 
any instructions in the 
package. Always handle 
sheets by the edges, and 
don’t touch the printable 
surface.

Caution:
Don’t use the cleaning 
sheets that may be 
included with your special 
media; they may damage 
the printer.
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However, you may get better results by loading one sheet at a 
time. With multiple sheets loaded, the minimum top margin 
you can use is 1.2 inches (30 mm). If you want to use a smaller 
top margin, load and print one sheet at a time.

Remove each sheet from the output tray immediately after it’s 
printed. Make sure each sheet is dry before stacking.

To print on transparencies, remove the paper support and 
reposition it in the slots at the back of the printer as shown:

Envelopes

You can load up to 10 envelopes as shown below:

Note:
Use ink jet papers within 
one year of purchase. 
Use glossy media and 
transparencies within six 
months. Return unused 
sheets and envelopes to 
their original package as 
soon as possible. See 
Appendix B for more 
storage information.
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If ink smears when you print on envelopes or other thick media, 
set the paper thickness lever to the + position. Open the printer 
cover and position the lever as shown below. Then close the 
cover and print. (Make sure you return the lever to the 0 
position before you print on other media.)

EPSON Photo Quality Ink Jet Cards

You can use these cards to print photographs that look almost as 
good as the ones you get from film processing. Make sure you 
set the paper thickness lever to the + position as shown above. 

You can load up to 30 cards at a time. Always place the 
included support sheet under the cards. When you’re ready to 
print, use your software to set the Paper Size option for the 
size card you’re using.

EPSON Photo Quality Self Adhesive Sheets

Use these sheets to print labels or stickers. You can load one 
sheet at a time.

Set the thickness lever 
to + if ink smears when 
you print on envelopes 
or cards.
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EPSON Iron-On Transfer Paper

You can print photos, company logos, or anything else you 
want on this paper, and then transfer your images to T-shirts or 
other cloth items. Load one sheet of transfer paper at a time. 
After you print, follow the instructions that came with the 
paper to iron the image onto the shirt or other item.

Printing Banners and Other 
Custom Size Projects
You can use banner paper or ordinary (continuous-form) 
computer paper to print a banner up to 44 inches long. You can 
also print on any size paper that fits into the printer (at least 
3.94 inches in width and height), by using the custom page size 
feature of your printer software on either a Windows computer 
or a Macintosh.

1. To make a 44-inch banner, first tear off four sheets of 
banner paper or continuous-form computer paper. If you’re 
using computer paper, tear off the perforations at the edges.

2. Insert the paper in the printer as shown:

For iron-on transfers, 
make sure you reverse 
your image before you 
print it, especially if it 
includes text. Then the 
text will read correctly 
when it’s transferred. You 
can use the Flip 
Horizontal option in your 
printer software. See 
page 3-6 for more 
information.

easch2.fm5  Page 6  Tuesday, January 14, 1997  9:49 AM



Printing on Special Media

2-7

3. Follow the instructions below to print your banner on 
either a Windows computer or a Macintosh.

Printing a Banner from Windows

Follow these steps to print a banner or other custom size 
document on a Windows computer:

1. Create the document in your word processor or other 
application software. You can create a banner in either 
portrait or landscape orientation. 

2. Click the Print icon or choose Print or Print Setup from 
the File menu. You see a printing dialog box.

3. Make sure your printer is selected, and then click the 
Printer, Setup, Properties, or Options button. (You may 
have to click a combination of these buttons.) You see the 
Main printer settings dialog box, as shown on page 1-2.

4. Click the Paper tab. You see a dialog box like the 
following:

Click to 
display list of 
paper sizes.
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5. Choose the paper you want to use from the Paper Size list. 
If you want to print a banner or other custom-size 
document, choose User Defined. 

If you choose User Defined, the following dialog box 
appears:

6. To print a banner, type 8.5 inches for the Paper Width 
and 44 inches for the Paper Height. (This works for both 
“landscape” and “portrait” style banners.) Click OK.

7. Choose Portrait or Landscape if you haven’t already 
specified the orientation in your application software. Set 
the printable area if necessary.

8. Click OK again to return to the Main printer settings dialog 
box. Make sure you choose Plain Paper and the other 
settings you want to use, and then click OK. Click Close, 
OK, or Print to print your banner. You may need to click a 
combination of these buttons.

Printing a Banner from a Macintosh

Follow these steps to print a banner or other custom size 
document on a Macintosh:

1. Create the document in your word processor or other 
application software. You can create a banner in either 
portrait or landscape orientation. 

2. Choose Page Setup from the File menu. 

For banner printing, type 
any size up to 44 inches.
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You see a dialog box like the following:

3. Choose Portrait or Landscape, depending on the 
orientation of the banner or document you created. Set the 
printable area if necessary.

4. Choose the paper you want to use from the Paper Size list. 
If you want to print a banner or other custom-size project, 
click the Customize button. The following dialog box 
appears:

5. Click the New button. The dialog box changes:

Click to display list of paper sizes.

Click to define your 
own paper size.

Letter

Click to create a 
new paper size

Type a name for 
your size here.
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6. Type a name for your custom size in the New Paper Size 
box. 

7. To print a banner, type 8.5 inches for the Width and 44 
inches for the Height. (This works for both “landscape” 
and “portrait” style banners.) Click OK, then OK again.

8. Choose Print from the File menu or click the Print icon in 
your application. You see a printer settings dialog box like 
the one shown on page 1-6. Make sure you choose Plain 
Paper and the other settings you want to use, and then 
click Print to print your banner. 

You can create up to eight 
custom paper sizes. If you 
give each one a unique 
name, you’ll be able to 
reuse them by selecting 
them from the Page Size 
list in the Page Setup 
dialog box.
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When you want to print presentation graphics, photographs, or 
other special projects, you can use the custom settings in your 
EPSON Stylus COLOR 800 software. You can choose 
predefined settings or adjust individual options like brightness, 
contrast, saturation, and halftoning. For professional-quality 
color accuracy, you can use Image Color Matching (ICM) 
under Windows 95 or ColorSync on the Macintosh.

This chapter includes the following information:

◗ Using predefined advanced settings

◗ Customizing print quality and special effects

◗ Customizing color settings

◗ Using ColorSync on the Macintosh

◗ Saving custom settings

Using Predefined Advanced 
Settings
Predefined settings provide an easy way to fine-tune your 
printer’s operation for special purposes. Follow these steps to 
print with predefined settings:

1. Create your document, image, or project in your 
application software.

Custom Printing
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2. Access the Main printer settings dialog box as described on 
page 1-2 (Windows) or page 1-6 (Macintosh).

You see one of the following dialog boxes:

3. Choose Color or Black ink.

Note
When you use advanced 
settings, the 
Quality/Speed slider 
disappears.

Windows

Click Advanced, then click here 
to see a list of project types.

Macintosh

Click Advanced, then click here 
to see a list of project types.
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4. Click Advanced, and then Custom Settings. You see the 
list of project types.

5. Follow these guidelines to choose the right setting for your 
project:

◗ Photo
For printing scanned photographs. Increases contrast 
in the image.

◗ Text/Graph
For printing graphics-intensive documents like 
presentation pages with charts and graphs. Intensifies 
colors and lightens the midtones and highlights.

◗ Video/Digital Camera
For images captured from a digital camera or video. 
Increases color brightness and makes the image sharper.

◗ Economy
For rough drafts of text only, on plain paper. Saves ink. 

◗ ICM (Windows 95 only)
Automatically adjusts printout colors to match the 
colors on your screen.

◗ ColorSync (Macintosh only)
Automatically adjusts printout colors to match the 
colors on your screen. For more information, see 
page 3-9.

6. Choose the Media Type you want to print on. The 
available media are limited by the project you choose. For 
example, you can’t use plain paper or transparencies with 
the ICM or ColorSync settings.

7. Click Print (Macintosh) or OK (Windows). If you’re using 
Windows, click any other buttons that your application 
uses for printing.

Note:
See Chapter 2 for 
information about using 
special media.
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Customizing Print Quality and 
Special Effects
If you need the maximum control over your project, or you 
want to experiment with special effects, you can adjust 
individual settings in your printer software. Follow these steps:

1. Create your document, image, or project in your 
application software.

2. Access the Main printer settings dialog box as described on 
page 1-2 (Windows) or page 1-6 (Macintosh).

3. Click Advanced, and then click More Settings. You see 
the More Settings dialog box:

After you customize your 
print settings for a special 
project, you can save 
them as a group. Then 
you can reuse them 
whenever you print a 
similar project. See 
page 3-11 for instructions.

Some of these options are 
automatically set or disabled by other 
settings you choose.

Windows
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4. Choose one of the following Print Quality options:

◗ Economy
For low-resolution rough drafts on plain paper. Saves 
ink.

◗ Normal - 360 dpi
For most documents on plain paper, transparencies, or 
360 dpi Ink Jet paper.

◗ Fine - 720 dpi
For high-resolution output. Works best on Photo 
Quality media.

◗ SuperFine - 1440 dpi
For the highest-resolution output on Photo Quality 
media only.

5. Choose the Media Type and Ink settings you want to use, 
following the guidelines in Chapters 1 and 2. 

Macintosh

Some of these options are 
automatically set or disabled by other 
settings you choose.

Note:
The Print Quality option 
you choose limits your 
choice of Media Types.

easch3.fm5  Page 5  Monday, November 25, 1996  4:35 PM



Custom Printing

3-6

6. Choose one of the following Halftoning options:

◗ No Halftoning
For printing black text only.

◗ Error Diffusion
For printing photographic or video/digital camera 
images. Blends each dot of color with the surrounding 
dots.

◗ Dithering
For printing charts, graphs, and other images that 
require precise, solid areas of bright colors. Arranges 
dots in orderly patterns. Use Coarse for images with 
more shading and less detail. Use Fine for images with 
more detail and less shading.

7. Choose any of the following options. Some of these settings 
are automatically selected or disabled by the Print Quality 
(resolution) you choose.

◗ MicroWeave
For improved print quality. Prints graphic data in finer 
increments to eliminate unwanted banding effects 
(light horizontal lines). Always use for color printing.

◗ High Speed
For fast, bidirectional printing at lower quality.

◗ Flip Horizontal
Prints a mirror image of your document. Use for 
printing with iron-on transfer paper. When you iron 
the printout onto a T-shirt or other item, it will read 
correctly.

◗ Finest Detail
For printing text, graphics, and line art with very sharp 
edges. Slows print speed and increases your system 
memory requirements. 

8. Click OK if you’re ready to print, or see the next section if 
you want to adjust your printer’s color settings.

If vertical lines in your 
printout are misaligned 
when you use the High 
Speed setting, you may 
need to align the print 
heads. See Chapter 5 for 
instructions.
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Customizing Color Settings
You can choose from several color adjustment modes or 
manually adjust brightness, contrast, and saturation. For 
professional color correction, you can set individual CMY color 
values. To achieve the maximum color accuracy, you can use 
Image Color Matching (ICM) under Windows 95 or 
ColorSync on the Macintosh.

Follow these steps to customize your color settings:

1. Access the More Settings dialog box as described on 
page 3-4.

The color settings appear on the right side of the dialog 
box, as shown:

Windows

Click to set Color Adjustment Mode.

Drag 
sliders to 
set 
values 
between 
-25% and 
+25%.

Click to set Color Adjustment Mode.

Macintosh
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2. Choose one of the following Color Adjustment Modes:

◗ Automatic
Analyzes the color information in your project and 
optimizes color correction accordingly.

◗ Photo-realistic
For printing color photographs. 

◗ Vivid
For printing graphics-intensive documents like 
presentation pages with charts and graphs. Intensifies 
colors and lightens the midtones and highlights. 

◗ No Color Adjustment (Macintosh only)
Choose this mode only if you’re using ColorSync.

3. If you want to specify individual color correction values, 
use the sliders to increase (drag right) or decrease (drag left) 
the settings listed below. (If you want to use the options 
described in step 4, you won’t be able to specify individual 
color correction values.)

◗ Brightness
Makes your image lighter or darker.

◗ Contrast
Increases or decreases the difference between the bright 
or dark parts of an image.

◗ Saturation
Makes colors more vivid or less vivid.

◗ Cyan, Magenta, Yellow
Increases or decreases the amount of the three ink 
colors that combine to make a full-color picture. Use 
these sliders to fine-tune the color balance in your 
printout.

easch3.fm5  Page 8  Monday, November 25, 1996  4:35 PM



Custom Printing

3-9

4. Choose Video/Digital Camera, ICM (Windows 95) or 
ColorSync (Macintosh):

◗ Video/Digital Camera
Use for printing images captured from a digital camera 
or video. Increases color brightness and makes the 
image sharper. 

◗ ICM (Windows 95 only)
Automatically adjusts printout colors to match colors 
on the screen. 

◗ ColorSync (Macintosh only)
Automatically adjusts printout colors to match colors 
on the screen. See “Using ColorSync on the 
Macintosh” for more information.

5. Click OK to return to the Main printer settings dialog box.

6. Click Save Settings if you want to save your custom 
settings as a group that you can reuse for special projects. 
See page 3-11 for more information about saving settings.

7. Click Print (Macintosh) or OK (Windows). If you’re using 
Windows, click any other buttons that your application 
uses for printing.

Using ColorSync on the Macintosh 
Every device you use for producing or viewing colors—your 
monitor, scanner, and printer—uses a different color 
technology. That’s why it’s difficult to get printed colors to 
match the colors displayed on your monitor or other device. 
The Macintosh ColorSync system helps you control all your 
devices so their colors match your printer’s as closely as possible. 

ColorSync uses profile information from each device—
including your EPSON Stylus COLOR 800 printer—to achieve 
accurate color matching. First you have to make sure your 
monitor’s profile is set. Then you can use your printer software 
to specify the exact method of color matching you want to use.

Note:
When you choose 
Video/Digital Camera, 
ICM, or ColorSync, all the 
other color options are 
preset.

For more information 
about color matching 
and working with 
color, see Print It in 
EPSON Color, the 
booklet that came 
with your printer.
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Follow these steps to set your monitor’s ColorSync profile and 
use your printer software’s ColorSync features:

1. Open the ColorSync System Profile under 
ControlPanels on the Apple menu.

2. Click the Set Profile button.

3. Select your monitor from the list, and then click Select.

4. Access the More Settings dialog box as described on 
page 3-4. 

5. Click ColorSync.

6. For Profile, choose EPSON Standard. 

7. Choose one of the following options for Rendering Intent:

◗ Perceptual
For printing scanned photographs. 

◗ Saturation
For printing graphics-intensive documents like 
presentation pages with charts and graphs. 

◗ Colorimetric
For matching colors on your screen as exactly as 
possible, within the limits of desktop technology. 
Reproduces colors the way your eye distinguishes them.

8. Click OK, and then click Print.

Note:
The EPSON Standard 
profile is custom-
designed for your printer. 
If you use a scanner or 
other color imaging 
equipment, you may have 
other profiles on your 
Macintosh. 
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Saving Custom Settings
After you’ve fine-tuned your printer settings for a special 
project, you can save the settings as a group. Then you can 
quickly reuse them the next time you print a similar project. 
Follow these steps:

1. Customize your printer settings as described in this chapter.

2. Click the Save Settings button on the Main printer 
settings dialog box. 

You see one of the following:
 

3. Type a unique name for your settings and click the Save 
button.

The name you choose will now be available on the Main 
printer settings dialog box when you click Advanced, and 
then Custom Settings.

Windows

Macintosh
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Your printer software includes several utilities for managing 
print jobs. You can use them to schedule large jobs for 
convenient times, monitor your printer’s status, and handle 
network printing. If you’re using your printer on a network, 
you need to follow special setup procedures. 

This chapter provides instructions for the following:

◗ Managing Print Jobs in Windows

◗ Managing Print Jobs on a Macintosh

◗ Network Printing on a PC

◗ Newwork Printing on a Macintosh

Managing Print Jobs in Windows
Your Windows printer software includes two management 
utilities: the Spool Manager and Status Monitor. 

◗ The Spool Manager starts automatically when you send a 
job to the printer. It allows you to print in the background 
while you continue to work on your computer and to 
queue jobs to print at a later time. If you’re using your 
printer on a network, it also handles multiple print jobs 
that come in at the same time.

Managing
Print Jobs and

Network Printing
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◗ The Status Monitor, which is available only if you’re using 
Windows 95, also starts automatically when you send a job 
to the printer. It displays in the lower right corner of your 
screen to alert you about printer and ink status, as described 
on page 1-5. 

Using the Spool Manager

The Spool Manager works like the Windows Print Manager.

◗ To open it while you’re printing, click the Spool Manager 
icon that appears on the Taskbar (Windows 95) or at the 
bottom of your desktop (Windows 3.1). 

◗ To open the Spool Manager at any time, double-click the 
Spool Manager4 icon in the EPSON program group or 
folder.

You see the Spool Manager window:

When you send a job to your printer, your printer software 
creates a temporary journal file, stores it in the C:\TEMP or 
C:\WINDOWS\TEMP folder or directory, and assigns it to a 
print queue. The software then sends the file to your printer at 
the right time.

Note:
The Status Monitor 
doesn’t work if you’re 
printing over a network.

queue journal file

menus
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The Spool Manager window displays the status of your print 
queues and journal files and lets you control them. Here are 
some of the things you can do:

◗ Hold or release a queue

◗ Send journal files to your printer over a network 

◗ Hold, re-queue, or delete a journal file

◗ Select the information you want to see in the Spool 
Manager window

◗ Prevent the Despooler popup window from appearing on 
your screen whenever you print

◗ Change your default spool directory

Deleting a Stalled Print Job

If you’re having trouble printing, it may be because of a stalled 
print job. Follow these steps to delete it so you can continue 
printing:

1. Open the Spool Manager as described on page 4-2.

2. Click on any print jobs marked Held, then open the 
Document menu and click Delete. 

3. Exit Spool Manager and try printing again.

Changing the Default Spool Directory

If you get an error message when you try to print, or printing is 
very slow, you can try changing your default spool directory. 
Follow these steps:

1. Make a directory on your hard drive where you want Spool 
Manager to store journal files, for example, C:\SPLTEMP.

2. Open the Spool Manager as described on page 4-2.

For information about any 
of these procedures and 
more, use the Spool 
Manager Help menu.
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3. Make sure EPSON Stylus COLOR 800 is selected, and then 
choose Setup from the Queue menu. The Queue Setup 
dialog box appears.

4. Change the spool directory to the one you created in step 1. 
Also make sure Use Print Manager for this port is 
checked. (If you don’t see the Status Monitor when you 
print, make sure it’s unchecked.) Then click OK.

5. Choose Default Spool Directory from the Options menu. 

6. In the dialog box, change the spool directory to the one you 
created in step 1. Then click OK.

7. Close Spool Manager.

Using the Status Monitor

The Status Monitor, available only if you’re using Windows 95, 
displays automatically when you send a job to the printer. 
However, you can use it at any time to see how much ink you 
have left. Follow these steps:

1. Access the Main printer settings dialog box as described on 
page 1-2 or 1-4.

2. Click the Utility tab.
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You see the Utility menu:

3. Click the Status Monitor icon. You see the Despooler 
window with the Status Monitor at the bottom:

4. Check the amount of ink you have left. For more 
information about the Despooler window, see page 1-5.

For information 
about these 
three utilities, 
see Chapter 5.
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Enabling the Status Monitor

If the Status Monitor doesn’t appear on the Despooler window, 
you may need to check your bidirectional spool settings. Follow 
these steps:

1. Click Start, point to Settings, and then point to Printers.

2. Right-click the EPSON Stylus COLOR 800 icon.

3. Select Properties. Then click the Details tab. 

4. Click Spool Settings. 

5. Make sure Enable bi-directional support for this printer 
is turned on. Then click OK.

Managing Print Jobs on a 
Macintosh
Your Macintosh printer software includes two management 
utilities: Monitor2 and Status Monitor. 

◗ If you’re using background printing, Monitor2 starts 
automatically when you send a job to the printer. It handles 
background printing while you continue to work on your 
Macintosh and lets you track documents that are waiting to 
be printed. 

◗ The Status Monitor alerts you to any problems that occur 
during printing. You can also use it at any time to see how 
much ink you have left. 

Using Monitor2

The Monitor2 utility lets you continue to work on your 
Macintosh while your document is printing. However, 
background printing is slower and may also slow down your 
system. 
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If you want to use this utility, you need to turn on background 
printing in the Chooser and increase the memory allocation for 
Monitor2. Follow these steps to turn on background printing 
and use the Monitor2 utility:

1. Open the Chooser from the Apple menu and make sure 
your EPSON Stylus COLOR 800 printer is selected.

2. Under Background Printing, click On and close the 
Chooser.

3. Select EPSON Monitor2 in your System folder.

4. Choose Get Info from the File menu. 

5. Set the Memory Requirements to 2000 or 3000, depending 
on your system’s available RAM.

6. While you’re printing, click the EPSON Monitor2 icon on 
the Application menu at the right end of the menu bar. You 
see a dialog box like the following:

7. You can select a job and cancel it or just use this window to 
track the printer’s progress. 

job currently 
printing

jobs queued 
for printing
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Using the Macintosh Status Monitor

You can use the Status Monitor to check the level of ink in your 
printer and to control the way your software warns you about 
printer problems. Follow these steps:

1. Choose Print from the File menu or click the Print button 
in your application. You see the printer settings dialog box.

2. Click the Utility button. You see the Utility menu:

3. Click the StatusMonitor icon. The software checks the 
amount of ink remaining in the printer and displays the 
StatusMonitor window:

For 
information 
about these 
three 
utilities, see 
Chapter 5.

Click to recheck ink level.Click to control messages 
and warnings.
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4. If you want to change printer messages and warnings, click 
the Configuration button. You see the following dialog 
box:

5. Choose the options you want and click OK.

Network Printing on a PC
You can use your printer on a network under Windows 95 or 
other network operating systems. First you need to set up your 
printer, using either your printer software’s built-in network 
support or the network’s LPT port redirection functions. 

When you use your printer’s built-in support, the Spool 
Manager sends journal files from your computer to a shared 
directory on a network server. These files can then be printed 
from another computer attached to the printer. 

First you need to run Spool Manager and identify the shared 
directory to use for journal files. After you set this up on the 
computer connected to the printer (the host system), you need 
to perform a similar procedure on each remote system on the 
network. 

Under Windows 95, you also need to specify the port and 
network path to the printer.

Printing stops 
when these 
messages 
appear.

Printing 
continues when 
these messages 
appear.

Note:
If you need to install a 
network interface board 
in your printer, see 
Appendix A for 
instructions.
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Setting Up the Host System

Follow these steps to set up the computer connected to the 
printer:

1. Create an icon for the EPSON Spool Manager 
(EPSPLMGR.EXE in the \WINDOWS\SYSTEM folder 
or directory).

2. Place this icon in the Startup folder.

3. Open the Spool Manager window as described on page 4-2.

4. In the Spool Manager window, double-click the queue you 
want to use for network printing. The Queue Setup dialog 
box appears.

5. Click the Remote Despool tab and then click the 
Printing from remote queues option.

6. Click the Browse button and select the remote server 
directory that will receive journal files.

7. Click OK and minimize the Spool Manager.

Setting Up Remote Systems

Follow these steps to set up computers on the network:

1. Create an icon for the EPSON Spool Manager 
(EPSPLMGR.EXE in the \WINDOWS\SYSTEM folder 
or directory).

2. Open the Spool Manager window as described on page 4-2.

3. In the Spool Manager window, double-click the queue you 
want to use for network printing. The Queue Setup dialog 
box appears.

4. Click the Spool to remote printer button.
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5. Click the Browse button and select the directory you’re 
using for journal files on the host system.

6. Click OK and minimize the Spool Manager.

Setting Up Your Network Path in 
Windows 95

If you want to use your printer on a network running 
Windows 95, you need to set up the port and network path 
on the computer connected to the printer. Follow these steps:

1. Double-click My Computer.

2. Double-click the Printers folder.

3. Right-click the EPSON Stylus COLOR 800 icon and 
choose Properties.

4. Click the Details tab. A dialog box like the following 
appears:
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5. Click the Add Port button, then specify the network path 
to the printer and click OK.

6. Open the Spool Manager window as described on page 4-2.

7. In the Spool Manager window, double-click your printer’s 
queue. The Queue Setup dialog box appears.

8. Make sure the Use Print Manager for this port option is 
checked. Then click OK.

Network Printing on a Macintosh
If you want to use your printer on an AppleTalk™ network, you 
need to install one of the optional interface boards: either the 
LocalTalk™ board or the Ethernet™ board. See Appendix A for 
more information about optional interfaces.

Then you can use the EPSON Namer utility and set up your 
printer in the Chooser. The EPSON Namer was installed on 
your hard drive along with the other printer software. 

Assigning a Name to the Printer

Follow these steps to use the EPSON Namer utility:

1. Double-click the EPSON Namer icon on your hard drive. 

2. Click the EPSON Stylus(AT) icon in the Device Types 
window.

3. Select the zone where your printer is located.

4. Under New Name, type a name from your printer to 
distinguish it from other printers on the network.

5. Click Rename and then click Done.
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Using the AppleTalk Connection

Make sure your printer is turned on and then follow these steps 
to set up your printer on an AppleTalk network:

1. Open the Chooser from the Apple menu. You see a dialog 
box like the following:

2. Click the EPSON Stylus(AT) icon.

3. Select the AppleTalk zone you want to use. A list of all 
printers connected to the selected zone appears on the right.

4. Click the name you assigned to your EPSON Stylus 
COLOR 800. You see a prompt asking you to confirm your 
choice.

5. Click OK.

If your printer name doesn’t appear, make sure the printer 
is turned on and correctly connected, then click RETRY.

6. To ensure compatibility, leave Background Printing 
turned off.

7. Close the Chooser when you’re finished.
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It’s easy to keep your EPSON Stylus COLOR 800 printer 
working at its best. All you have to do is follow the simple 
instructions in this chapter for replacing ink cartridges, moving 
the printer, and performing routine maintenance. You can use 
your printer software utilities to clean and align the print heads 
whenever necessary. 

This chapter covers the following procedures:

◗ Replacing an ink cartridge

◗ Cleaning the print heads

◗ Aligning the print heads

◗ Cleaning the printer

◗ Transporting the printer

Replacing an Ink Cartridge
When a B black or A color ink out light flashes, the indicated 
cartridge is low on ink. This is a good time to make sure you 
have a new cartridge. When the light stays on, the cartridge is 
empty and you need to replace it.

When you need new ink cartridges, contact your dealer or call 
EPSON Accessories at (800) 873-7766 (U.S. only). In Canada, 
please call (800) 873-7766 for dealer referral.

Maintenance and
Transportation

Caution:
To ensure good results, 
use genuine EPSON 
cartridges and do not 
refill them. Other 
products may cause 
damage to your printer 
not covered by EPSON’s 
warranty.
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Use these EPSON ink cartridges within six months of installing 
them and before the expiration date on the package:

◗ Black ink cartridge   S020108

◗ Color ink cartridge    S020089

When the A color ink out light comes on, you can continue to 
print with black ink. Simply turn the printer off and then back 
on again. When you print, make sure you choose Black as the 
Ink setting in your printer software. 

Removing an Empty Ink Cartridge

You can replace a cartridge when the B black or A color ink 
out light is either flashing or on. Make sure the printer is turned 
on and not printing before you start. Then follow these steps:

1. Determine which cartridge needs to be replaced.

2. Lower the output tray and raise the printer cover. Then 
locate the Y black and X color cleaning buttons next to the 
control panel under the printer’s cover.

3. Press the Y black or X color cleaning button and hold it for 
three seconds. 

Caution:
To avoid damaging the 
printer, never move the 
print heads by hand.

black cleaning 
button

color cleaning 
button

Caution:
If you press the cleaning 
button when no ink out 
light is flashing or on, the 
printer cleans the print 
heads, as described on 
page 5-6. If you need to 
replace an ink cartridge 
before the lights flash 
(because the ink is too 
old, for example) follow 
the instructions on 
page 5-5.
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The print heads move slightly left and the Ppower light 
begins flashing. (The print heads return to their home 
position if you don’t proceed to step 4 within 60 seconds.)

4. Pull up the ink cartridge clamp. (Although the illustration 
shows the black ink cartridge, the procedure is the same for 
replacing the color ink cartridge.)

The cartridge rises up from its holder.

5. Lift the cartridge out of the printer and dispose of it 
carefully. 

6. Follow the steps in the next section to install the new ink 
cartridge.

Caution:
Don’t open the clamp or 
remove a cartridge 
except to replace it with 
a new one. Once you 
remove a cartridge, you 
can’t reuse it, even if it 
contains ink.

Warning:
If ink gets on your hands, 
wash them thoroughly 
with soap and water. If ink 
gets into your eyes, flush 
them immediately with 
water.
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Installing the New Cartridge

Once you have removed the empty cartridge, you’re ready to 
install the new one. Follow these steps:

1. Remove the new ink cartridge from its packaging. 

2. Remove the yellow tape seal as shown:

3. Lower the ink cartridge into its holder with the label facing 
up and the arrow pointing to the back of the printer.

4. Press down the ink cartridge clamp until it locks in place.

Caution:
You must remove the 
yellow tape seal from the 
top of the cartridge; 
leaving the tape on will 
permanently damage it. 
Do not remove the clear 
seal from the bottom of 
the cartridge; ink will leak 
out.

black cartridge color cartridge
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5. If you need to replace the other ink cartridge, follow the 
steps under “Removing an Empty Ink Cartridge,” and then 
steps 1 through 4 under “Installing the New Cartridge.”

6. Press the E load/eject button and close the printer cover. 

The printer moves the print heads and begins charging the 
ink delivery system. (Even if you don’t press the button, ink 
charging begins 60 seconds after you close the clamp.)

The Ppower light flashes, and the printer makes various 
sounds. Charging takes about two minutes. When it’s 
finished, you can print again.

Replacing an Outdated Ink Cartridge

If an ink cartridge is more than six months old, you may need 
to replace it. How can you tell? You may notice that your 
printouts don’t look as good as they used to. If print quality 
doesn’t improve after cleaning and aligning the print heads, you 
can replace one or both cartridges.

Follow these steps to replace an ink cartridge before the B black 
or A color ink out light is flashing or on:

1. Make sure the printer is turned on and not printing.

2. Lower the output tray and raise the printer cover. Then 
locate the Y black and X color cleaning buttons next to the 
control panel under the printer’s cover.

3. Press both the Y black and X color cleaning buttons and 
hold them down for a few seconds until the print heads 
move to the left.

◗ To replace the black ink cartridge, follow the 
instructions beginning with step 4 on page 5-3. 

◗ To replace the color ink cartridge, press the X color 
cleaning button and hold it down for a few seconds. 
After the color ink cartridge moves to the left, follow 
the instructions beginning with step 4 on page 5-3.

Caution:
Never turn off the printer 
while the P power light 
is flashing.

Caution:
To avoid damaging the 
printer, never move the 
print heads by hand.
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Cleaning the Print Heads 
If your printed image is unexpectedly light or faint, or dots are 
missing from the image, you may need to clean the print heads. 
This unclogs the nozzles so they can deliver ink properly.

Cleaning the print heads uses ink, so clean them only if print 
quality declines. You can clean the print heads in either of the 
following two ways:

◗ With the Head Cleaning utility in your printer software 
(when the printer is on a local port rather than a network)

◗ Using the printer’s control panel buttons

Using the Head Cleaning Utility

Follow these steps to run the utility from a Windows computer 
or a Macintosh:

1. Make sure the printer is turned on but not printing, and  
the B black and A color ink out lights are off.

2. Access the main printer settings dialog box as described in 
Chapter 1.

3. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

4. Click the Head Cleaning icon.

5. Follow the instructions on the screen to clean one or 
both print heads. Cleaning each head takes about two 
minutes, during which the printer makes some noise and 
the Ppower light flashes. 

When the power light stops flashing, you need to run a 
nozzle check.

Caution:
Never turn off the printer 
while the P power light is 
flashing.
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6. Make sure paper is loaded in the printer and click Print 
nozzle check pattern (Windows) or Confirmation 
(Macintosh). See page 5-8 for instructions on examining 
the nozzle check pattern.

If your print quality has not improved, repeat the steps above. If 
you don’t notice any improvement after doing this four or five 
times, check the print quality solutions in Chapter 6.

Using the Control Panel To Clean the Print 
Heads

Follow these steps to clean the print heads using the control 
panel buttons:

1. Make sure the printer is turned on and not printing, and 
that the B black and A color ink out lights are off. 

2. Open the printer cover.

3. Press the Y black or X color cleaning button and hold it for 
three seconds. Cleaning takes about two minutes, during 
which the printer makes some noise and the Ppower light 
flashes. 

4. When the Ppower light stops flashing, repeat step 2 for the 
other print head if necessary. 

After you’re finished cleaning and the Ppower light stops 
flashing, you need to run a nozzle check. 

5. Access the main printer settings dialog box as described in 
Chapter 1.

6. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

7. Click the Nozzle Check icon. See the next section for 
instructions on examining the nozzle check pattern.
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If your print quality has not improved, repeat the steps above. If 
you don’t notice any improvement after doing this four or five 
times, check the print quality solutions in Chapter 6.

Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print after cleaning the 
print heads. It should look something like this, with the lower 
pattern colored cyan, magenta, and yellow:

Each staggered horizontal and straight vertical line should be 
complete, with no gaps in the dot pattern. If your printout 
looks okay, you’re done. If any dots are missing, clean the print 
heads again, as explained in the previous sections.

Aligning the Print Heads 
If your printouts contain misaligned vertical lines, you may 
need to align the print heads. You can align the print heads in 
either of the following two ways:

◗ With the Print Head Alignment utility in your printer 
software (when the printer is on a local port rather than a 
network)

◗ Using the printer’s control panel buttons
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Using the Print Head Alignment Utility

Follow these steps to run the utility from a Windows computer 
or a Macintosh:

1. Make sure the printer is turned on and paper is loaded.

2. Access the main printer settings dialog box as described in 
Chapter 1.

3. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

4. Click the Print Head Alignment icon.

5. Follow the instructions on the screen to print a test page 
and select the correct alignment.

Using the Control Panel To Align the Print 
Heads

Follow these steps to align the print heads using the control 
panel buttons:

1. Make sure the printer is turned off and paper is loaded.

2. Open the printer cover.

3. Hold down the E load/eject button and the Y black 
cleaning button and turn on the printer. Then release the 
buttons.

The printer prints an instruction sheet that tells you how to 
align the print heads.

4. Follow the instructions on the printed sheet.

5. When you’re finished, turn off the printer to exit the 
alignment mode.

Caution:
Load paper that’s at least 
8.27 inches (210 mm) 
wide. This prevents ink 
from spraying inside the 
printer and smudging 
your printouts.
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Cleaning the Printer 
To keep your printer working at its best, you should clean it 
several times a year, following these steps:

1. Turn off the printer, unplug the power cord, and 
disconnect the printer cable.

2. Remove all the paper from the sheet feeder.

3. Carefully clean away dust and dirt with a soft brush.

4. Clean the exterior of the printer with a soft, damp cloth. 
Keep the printer cover closed so water doesn’t get inside.

5. Clean ink out of the printer’s interior with a soft, damp 
cloth.

Caution:

◗ Don’t touch the gears 
inside the printer.

◗ Never use alcohol or 
thinner for cleaning; they 
can damage the printer 
components and case.

◗ Don’t use a hard or 
abrasive brush.

◗ Don’t get water on the 
printer components.

◗ Don’t spray lubricants or 
oils inside the printer.
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Transporting the Printer
If you want to move your printer some distance, you need to 
prepare it for transportation and repack it in the original box. 
Follow these steps:

1. Turn on the printer and wait until the print heads lock in 
the far right position. Then turn off the printer.

2. Unplug the power cord from the electrical outlet. Then 
disconnect the interface cable from the printer.

3. Remove any paper from the sheet feeder and remove the 
paper support.

4. Push in the output tray extensions and close the tray.

5. Repack the printer and attachments in the original box 
using the protective materials that came with it. See the 
Notice Sheet that was packed with the printer.

Be sure to keep the printer flat as you transport it. If you notice 
a decline in print quality after transporting the printer, clean the 
print heads; if output is misaligned, align the print heads. See 
the instructions in this chapter.

Caution:
To avoid damage, 
always leave the ink 
cartridges installed 
when transporting the 
printer.
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As you use your printer, you may occasionally experience a 
paper jam or other problem. The first thing you should do is try 
to diagnose the problem, following the guidelines in this 
chapter. Then try the most likely solutions until the problem is 
fixed. 

This chapter tells you everything you need to know about the 
following:

◗ Diagnosing problems

◗ Improving print quality

◗ Solving printing problems

◗ Fixing paper jams and other paper problems

◗ Solving miscellaneous printout problems 

Your printer provides a number of ways to help you diagnose 
problems:

◗ To identify the most common problems, read the lights on 
the printer’s control panel. See the following section for 
more information.

◗ You can also use the Status Monitor utility to identify 
common problems. For instructions, see page 1-5 
(Windows 95) or page 4-8 (Macintosh).

◗ To determine whether the problem is caused by the printer 
itself, run a self test. See page 6-3 for instructions.

Troubleshooting
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◗ You can use the printer’s hex dump mode to pinpoint 
communication problems. Then you can fax the printout 
to a technical support representative or interpret it yourself. 
See page 6-3 for instructions.

◗ For the latest information, check the EPSON Stylus 
COLOR 800 Help program and the ReadMe file in the 
EPSON program group or folder. 

◗ If none of the suggested solutions in this chapter solve your 
problem, contact EPSON as described under “Where to Get 
Help” in the Introduction. 

Reading the Control Panel Lights

Follow these guidelines when the control panel lights come on 
or flash:
.

S When the paper light flashes, paper is jammed in the printer. 
Turn off the printer and gently pull out all paper. Then press 
the E load/eject button. See page 6-14 for more information.

S When the paper light comes on, your paper ran out or is 
incorrectly loaded. Load paper in the feeder and then press 
the E load/eject button. 

B A When an ink light flashes, your ink supply is low. Make sure 
you have a replacement cartridge.

B A When an ink light comes on, you need to replace the ink 
cartridge. See Chapter 5 for instructions.

P S B A When the power light and paper light flash and all the other 
lights are on, your printer has a carriage error. See page 6-9 
for more information.

P S B A When all the lights flash, your printer may have an internal 
error. See page 6-10 for more information.
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Running a Self Test

You can run a self test to determine whether the problem comes 
from the printer itself or the computer. 

◗ If the results are satisfactory, the problem lies in software 
settings, the interface cable, or your computer.

◗ If the self test does not print correctly, you have a problem 
with your printer. See the suggestions in this chapter for 
possible solutions.

Follow these steps to run the test:

1. Make sure both the printer and computer are turned off.

2. Disconnect the interface cable from the printer.

3. Make sure paper is loaded in the feeder.

4. Press the E load/eject button and hold it down while you 
press the Ppower button. Continue to hold the buttons 
until the Ppower light starts to flash.

The printer prints a nozzle check pattern (shown on 
page 5-8) and samples of fonts and colors. 

5. To end the test, turn off the printer.

Using Hex Dump Mode

You can use the printer’s hex dump mode to identify problems 
if you know how to interpret hex code. Or, you can fax the hex 
printout to a technical support representative. Follow these 
steps to use hex dump mode:

1. Make sure the printer is turned off and has paper in the 
feeder.

2. Open the cover.

easch6.fm5  Page 3  Tuesday, January 14, 1997  9:48 AM



Troubleshooting

6-4

3. Hold down the E load/eject button and the X color 
cleaning button and press the Ppower button. The printer 
prints Hex Dump Mode at the top of a page and then 
stops.

4. Print one or more pages from an application as usual. The 
printer prints the exact code it receives in hexadecimal 
format.

Improving Print Quality
If you find that your print quality has been declining, you can 
often improve it by doing one of the following:

◗ Clean the print heads following the instructions in 
Chapter 5.

◗ Use higher quality paper appropriate for your print job. 
(See Chapter 2 for a list of EPSON papers).

◗ Match the Media Type in the main printer settings dialog 
box to the type of paper or media you loaded in the printer. 
(See Chapter 1 for details).

◗ Turn off High Speed mode in the advanced printer settings 
dialog box, as described in Chapter 3.

◗ Replace the ink cartridges as described in Chapter 5. 
(Check the status of the B black and A color ink out lights 
first.)

On the following pages are some detailed solutions to specific 
print quality problems.
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Printed image has horizontal banding.

Vertical lines are misaligned or vertical banding appears.

The printed image has incorrect or missing colors.

Possible cause Solution

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the paper or media 
you’re using. Then the printer software can automatically select 
other settings for the best quality. See Chapter 1 for instructions.

The printable side of the 
paper is face down.

Remove the paper and reload it with the printable side face up. 
See Chapter 2 for instructions.

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 5 for instructions.

The ink cartridges are low on 
ink.

Check the B black and A color ink out lights to see which 
cartridge you may need to replace. See Chapter 5.

The MicroWeave option is 
not set.

Turn on MicroWeave in the advanced printer settings dialog 
box. See Chapter 3 for more information.

Possible cause Solution

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 5 for instructions.

The High Speed setting is 
turned on.

Turn off the High Speed setting if vertical lines are misaligned. 
See Chapter 3 for information.

The print heads are 
misaligned.

Run the Print Head Alignment utility. See Chapter 5 for 
instructions.

Possible cause Solution

The Ink option is set to 
Black.

Change the Ink setting to Color. See Chapter 1 for instructions.

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the paper or media 
you’re using. Then the printer software can automatically select 
other settings for the best quality. See Chapter 1 for instructions.

The printable side of the 
paper is face down.

Remove the paper and reload it with the printable side face up. 
See Chapter 2 for instructions.
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The printed image is faint or has gaps.

The Halftoning and Color 
Adjustment Mode 
options are set incorrectly 
for your document type.

Use the correct settings for the project you’re printing, following 
the instructions in Chapter 3.

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 5 for instructions.

The ColorSync settings 
are incorrect for your 
document (Macintosh).

Use the Automatic mode setting or choose a different 
Rendering Intent setting. See Chapter 3 for more information.

The ink cartridges are low 
on ink or one or more ink 
colors are empty.

Check the B black and A color ink out lights to see which cartridge 
you may need to replace. See Chapter 5 for instructions.

The colors displayed on 
your monitor don’t match 
the printed colors.

Because your monitor and printer use different technologies 
to represent colors, your printed colors can’t exactly match the 
colors you see on your monitor screen. Use the ICM 
(Windows 95) or ColorSync (Macintosh) settings. See Chapter 3 
for more information.

The color settings in your 
application software need 
adjustment.

You may be able to adjust various color settings in your application 
software. See your software documentation for more information.

Possible cause Solution

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 5 for instructions.

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the paper or media 
you’re using. Then the printer software can automatically select 
other settings for the best quality. See Chapter 1 for instructions.

The loaded paper is 
damaged, old, or dirty.

Remove the paper and reload a new stack with the printable side 
face up. See Chapter 2 for instructions.

The ink cartridges are low 
on ink.

Check the B black and A color ink out lights to see which cartridge 
you may need to replace. See Chapter 5 for instructions.

Possible cause Solution
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The printed image is blurry or smeared.

Photographic images look grainy or rough.

Possible cause Solution

The printer’s adjust lever is 
in the 0 position.

Set the adjust lever to the + position and try printing again. See 
Chapter 2 for instructions.

The paper is damp or the 
printable side is face down.

Remove the paper and reload a new stack with the printable side 
face up. See Chapter 2 for instructions.

You loaded special media 
without a support sheet.

Follow the special media loading instructions in Chapter 2 and on 
the paper packaging for media that require support sheets. Also 
try loading your media one sheet at a time.

You tried to print on 
cardboard or other 
non-recommended media.

Make sure your paper or media meets the specifications listed in 
Appendix B. If your printouts are still blurry after you change 
paper, clean the print heads as described in Chapter 5.

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the paper or media 
you’re using. Then the printer software can automatically select 
other settings for the best quality. See Chapter 1 for instructions.

Multiple sheets entering the 
output tray are smearing 
the ink on ejected pages.

Remove each sheet from the output tray as soon as it is printed to 
prevent smearing, especially if you use transparencies. 

Ink has leaked inside the 
printer.

Clean carefully inside the printer to remove spilled ink. See 
Chapter 5 for instructions.

The color ink cartridge is 
empty.

Replace the color ink cartridge following the instructions in 
Chapter 5 or choose Black ink in your printer software.

You’re using the High 
Speed and MicroWeave 
settings with a misaligned 
print head.

Turn off High Speed following the instructions in Chapter 3. Run 
the Print Head Alignment utility following the instructions in 
Chapter 5.

Possible cause Solution

The print heads are 
misaligned.

Run the Print Head Alignment utility following the instructions in 
Chapter 5.

The resolution of your 
image is too low.

Increase the image resolution using your image-editing software, 
or decrease the size of the image.
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Solving Printing Problems
If the printer won’t print, first check that:

◗ The printer is turned on and the Ppower light is on.

◗ Paper is loaded in the printer.

◗ The printer is plugged into a working electrical outlet that’s 
not controlled by a switch or timer.

◗ The interface cable is securely connected to the printer and 
computer and both are turned on. 

If you still can’t print, check the following solutions.

All lights are off.

Only the Ppower light is on, but nothing prints.

Possible cause Solution

The printer is not receiving 
power.

Try these solutions:
• Make sure the printer is turned on.
• Turn off the power and plug in the power cord securely.
• Make sure the outlet is not controlled by a switch or timer and
   is operable.

Possible cause Solution

The interface cable is not 
connected securely.

Turn off your printer and computer. Then make sure the cable is 
connected securely and meets the printer’s specifications. Try 
printing again.

The printer has an internal 
problem.

Turn off the printer and computer, disconnect the interface cable, 
and run a self test as described on page 6-3.

The printer or application 
software is installed 
incorrectly.

If the self test works, check your printer and application software 
for correct installation. If you’re printing on a network, you may 
need to set up your printer for network printing, as described in 
Chapter 4.

Your computer doesn’t 
have enough memory to 
handle the file you’re 
printing.

Try one of the following:
• Reduce the resolution of your image.
• Select fewer colors or a lower resolution for your display or
   monitor.
• Add more memory to your computer.
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The S paper out light is flashing or on.

A B black or A color ink out light is flashing or on.

The S and Plights are flashing.

Printing is stalled in Spool 
Manager (Windows).

Delete the stalled print jobs in Spool Manager and resume 
printing; see Chapter 4 for instructions.

Printing is stalled in 
Monitor2 (Macintosh).

Open the Extensions folder, EPSON folder, and Spool folder. 
Then delete any queued files.

The print heads are clogged 
or the ink cartridges are too 
old.

If the printer sounds like it’s trying to print but doesn’t feed paper, 
clean the print heads; see Chapter 5 for instructions. If cleaning 
doesn’t help, replace the cartridges. For information on cartridge 
life and replacement instructions, see Chapter 5.

Possible cause Solution

If flashing, paper is jammed. Remove the paper and follow the guidelines for preventing jams 
as described on page 6-14.

If on, paper is used up or is 
loaded incorrectly.

Load paper or remove the stack and reload it as described in 
Chapter 2. Then press the E load/eject button to turn off the light 
and resume printing.

Possible cause Solution

If flashing, the ink supply is 
getting low.

You need to replace the indicated ink cartridge soon; see 
Chapter 5 for instructions and make sure you have a new 
cartridge.

If on, the ink cartridge is 
empty.

You must replace the indicated ink cartridge now to be able to 
print; see Chapter 5 for instructions.

Possible cause Solution

A carriage error has 
occurred.

Remove any paper in the printer. Press the E load/eject button for 
about 30 seconds. Then press it again. Turn the printer off, wait a 
few seconds, and then turn it on and try printing again. If the error 
is not cleared, contact EPSON as described in the Introduction.

Possible cause Solution
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All the lights are flashing.

The printer has finished charging the ink cartridge, but the  P power 
light is still flashing.

The printer software installed with Windows 3.1 doesn’t work 
correctly after you upgrade to Windows 95.

After you install your printing software, you see the Windows 95 New 
Hardware found window.

Possible cause Solution

You haven’t removed all the 
packing material from the 
printer.

Remove the packing material, following the instructions on the 
notice sheet in the box. If the printer still doesn’t print, contact 
EPSON as described in the Introduction.

An internal error has 
occurred.

Turn off your printer, wait a few seconds, and turn it on again. If 
the lights still flash or stay on, contact EPSON as described in the 
Introduction.

Possible cause Solution

The ink cartridge clamp 
isn’t locked down.

Press down on the clamp to lock it.

Packing material remains in 
the carriage.

Remove all packing material, following the instructions on the 
notice sheet.

The printer needs to 
initialize.

If the printer is not moving or making noise, but the light is still 
flashing for more than 5 minutes, turn the printer off. If the light is 
still flashing when you turn it back on, contact EPSON as described 
in the Introduction.

Possible cause Solution

Your printer software is not 
set up correctly for 
Windows 95.

Reinstall the printer software after installing Windows 95.

Possible cause Solution

An operating system error 
has occurred.

Click Do not install a driver, and then click OK.
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You see a spooling error message (Windows).

You see a memory error message (Macintosh).

In Windows 95, the Status Monitor box does not appear with the 
Despooler.

A portion of your image doesn’t print (Macintosh).

Possible cause Solution

If you see error messages 
or printing is very slow, the 
problem may be caused by 
temporary files.

Change the Spool Manager default directory, following the 
instructions in Chapter 4.

Your hard drive is too full. Delete unnecessary files to make room on the drive.

Your computer doesn’t 
have enough memory for 
the file you’re printing.

Try one of the following:
• Reduce the resolution of your image.
• Select fewer colors or a lower resolution for your display or
   monitor.
• Add more memory to your computer.

Possible cause Solution

You need to increase the 
memory allocation for your 
application, EPSON 
Monitor2, or both.

Choose Get Info from the File menu when EPSON Monitor2 is 
highlighted and increase the Memory Requirements. See Chapter 4 
for more information. Also, turn off background printing if it’s on.

Possible cause Solution

The Windows Print 
Manager is interfering with 
the Status Monitor.

Make sure Use Print Manager for this port is not checked in 
the Spool Manager Queue setup. Then check your bidirectional 
spool settings. See Chapter 4 for instructions.

Possible cause Solution

Your system doesn’t have 
enough available memory.

Close any other applications you are running and turn off 
background printing.

You need to increase the 
memory allocation for your 
application, EPSON 
Monitor2, or both.

Choose Get Info from the File menu when the application is 
active and increase the Memory Requirements. See Chapter 4 for 
more information.
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Printing is too slow.

Your printer switches to the modem port or won’t confirm on the 
printer port (Macintosh).

Your printer icon doesn’t appear in the Chooser (Macintosh).

Possible cause Solution

Your printer software 
options are set incorrectly.

For faster printing, try the following:
• Set Print Quality to Economy.
• Turn MicroWeave off.
• Turn High Speed on.
• Choose No Halftoning.
• Choose Black ink.
See Chapters 1 and 3 for more information.

Your system doesn’t have 
enough resources.

• Clear space on your hard disk drive or run a defragmentation
   utility.
• Don’t run too many applications at the same time.
• Turn off virtual memory.
• Increase your system’s memory (RAM)

You’re using background 
printing on a Macintosh.

Choose Get Info from the File menu and increase the Memory 
Requirements for EPSON Monitor2 or turn off background 
printing.

Your port settings are 
incorrect in Windows 95.

Change your default spool directory and disable port settings as 
described in Chapter 4.

Possible cause Solution

Your Macintosh has 
extension confilcts.

Make sure AppleTalk is inactive. In the Extensions Manager, 
disable the AppleShare, FileShare, and PrinterShare extensions. 
Set your printer and any unused Apple printers to the printer port. 
Then restart your system.

You’re using an AppleTalk 
cable.

Make sure you’re using a standard Apple System Peripheral-8 
cable. See the Introduction for more information.

Possible cause Solution

Your Macintosh has 
extension confilcts.

Disable Quick Draw GX in the Extensions Manager. Make sure 
EPSON Monitor2 and EPSON Stylus Color are enabled, and then 
restart your Macintosh.
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Fixing Paper Problems
You can avoid most paper handling problems by doing the 
following:

◗ Use smooth, high-quality media designed for ink jet 
printers that meets the media specifications in the 
Appendix.

◗ Follow all loading and handling instructions included with 
the media.

◗ Load the media as described in Chapter 2 with the 
printable side face up.

If you have problems with paper feeding, paper jams, or ejected 
paper, check here for solutions.

Paper doesn’t feed.

Multiple pages feed at the same time.

Try this Then do this

Remove the stack of paper 
from the sheet feeder.

Check that the paper:
• Isn’t curled or creased.
• Isn’t too old. (See Chapter 2 or your paper packaging for more
   information.)
• Isn’t loaded above the arrow on the left edge guide.
• Isn’t jammed inside the printer. (If the S paper out light is
   flashing, paper is jammed.)
Then reload the paper as described in Chapter 2, making sure the 
left edge guide is adjusted to fit the paper’s width.

Try this Then do this

Remove the stack of paper. • Make sure the paper isn’t too thin (see the paper specifications
   in Appendix B).
• Fan the edges of the stack of paper to separate the sheets.
• Reload the paper as described in Chapter 2.
• If too many copies of a page or document are printing, check the
   Copies settings in both the printer settings dialog box and your
   application program. See Chapter 1 for more information.
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Paper jams inside the printer.

Paper doesn't eject fully or is wrinkled.

Try this Then do this

Turn off your printer, open 
the cover, and remove all 
the paper that’s inside, 
including any little pieces 
that may have torn off. 

Load more paper in the printer, following the instructions in 
Chapter 2 and on the Quick Setup. If your paper jams frequently, 
make sure you:
• Use smooth, high-quality paper, loaded printable side up.
• Fan the stack and then even the edges before loading it.
• Load paper beneath the arrow mark on the left edge guide.
• Adjust the left edge guide to fit the width of your paper.

Possible cause Solution

If the paper doesn’t eject 
fully, you may have set the 
wrong paper size.

Press the E load/eject button to eject the paper. Then make sure 
you select the correct paper size in your application or printer 
software.

If it’s wrinkled when it 
comes out, the paper may 
be damp or too thin.

See the paper specifications in Appendix B for ranges of paper 
thicknesses you can print with, as well as environmental 
requirements for storage.
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Solving Miscellaneous Printout 
Problems
If your printout results are not what you expected, try these 
solutions.

Characters are incorrect or garbled.

.

The margins are incorrect.

The image is inverted as if viewed in a mirror.

Possible cause Solution

Your printer is not the 
Windows default printer.

Select your printer as the default Windows printer. See your 
Windows documentation or online help for instructions.

Printing is stalled in Spool 
Manager.

Delete the stalled print jobs in Spool Manager following the 
instructions in Chapter 4. Then try printing again.

If you’re using background 
printing on a Macintosh, 
spooled data may be 
corrupted.

Open the Extensions folder, EPSON folder, and Spool folder. 
Then delete any queued files. Increase the Memory 
Requirements for EPSON Monitor2.

The interface cable is not 
securely connected.

Turn off your printer and computer. Then make sure the cable is 
connected securely and meets the printer’s specifications.

Possible cause Solution

Margins are set incorrectly in 
your application software.

Check your software documentation for instructions on selecting 
the correct margins for your paper size.

Paper settings in the printer 
software are incorrect for 
your paper size.

Check the settings in the paper dialog box to make sure they’re 
correct for your paper size. See Chapter 2 for more information.

Possible cause Solution

You used a Flip 
Horizontal option in your 
application software or the 
printer software.

Turn off the Flip Horizontal or Mirror setting in your application 
software or the printer software. See Chapter 3 for instructions.
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The printer prints blank pages.

Possible cause Solution

Your printer is not the 
Windows default printer.

Select your printer as the default Windows printer. See your 
Windows documentation or online help for instructions.

Paper settings in the printer 
software are incorrect for 
your paper size.

Check the settings in the paper dialog box to make sure they’re 
correct for your paper size. See Chapter 2 for more information.

The print head nozzles are 
clogged.

Clean the print heads following the instructions in Chapter 5.
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Your EPSON Stylus COLOR 800 includes both parallel and 
serial interfaces. You can connect it to a PC or Macintosh, or 
both at the same time. If you want to connect to another system 
or to a network, you can install an optional interface board. 

This chapter tells you how to install and use EPSON interface 
boards in the following sections:

◗ Selecting an interface board

◗ Using Macintosh interface boards

◗ Using the PC serial interface board

◗ Installing optional interfaces

Selecting an Interface Board
You can install the following interface boards in your printer:

Using Optional
Interfaces

Type of interface board Model number Compatibility

Serial C823051 PC

32KB serial C832071 PC

32KB parallel C823101 PC

LocalTalk C823121 Macintosh

Twinax C823151 PC

Coax C823141 PC

Ethernet C823461 Macintosh/PC 
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To order an interface board, contact your dealer or call EPSON 
Accessories at (800) 873-7766 (U.S. sales only). In Canada, call 
(800) 873-7766 for dealer referral. 

Using Macintosh Interface Boards
If you are planning to install the LocalTalk board, you will also 
need two LocalTalk Locking Connector Kits (DIN-8 version). 
Attach one connector box to the AppleTalk interface on the 
printer and the other to the printer port on the Macintosh. 
Then attach the LocalTalk cable between the two connector 
boxes. For more information, see the instructions that came 
with the connector kits.

If you install the Ethernet board connected to a thin coaxial 
(10BASE2) cable, and the printer is the last device on the 
network, you need to obtain a 50-ohm terminator. The 
Ethernet transceiver is included on the EPSON Ethernet board, 
so you do not need an adapter box for the printer. 

Using the PC Serial Interface Board
Before you install the serial interface board in your printer, 
follow the instructions that come with the board for setting 
baud rate and parity. Refer to your computer documentation 
for information about matching the board’s settings to your 
computer system. You may also need to set the board’s 
handshake timing, error handling, and other data transfer 
conventions.
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Installing Optional Interfaces 
Before you install an optional interface board in your printer, 
make sure the printer is turned off and all the printer’s lights are 
off. Then follow these steps:

1. Unplug the power cord from the electrical outlet (and from 
the back of the printer, if your printer’s power cord is 
removable).

2. Turn the printer around so that its back faces you, and 
disconnect any interface cables.

3. Use a cross-head screwdriver to remove the two screws 
securing the shield plate to the interface slot; then lift off 
the plate. Be sure to keep both screws; you may need to use 
them again when you reinstall the shield plate.

4. Be sure to set any switches and jumpers on the board. See 
the interface board’s manual for details. If your board has a 
jumper labeled JG, make sure that you set it to on, or the 
board will not work properly.

Caution:
To avoid damaging your 
printer or computer, do 
not install the interface 
board when the printer is 
connected to an electrical 
outlet. 
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5. Slide the interface board along the slots on both sides of the 
compartment. Push it in firmly to fully insert the board’s 
connector into the printer’s internal socket.

6. Secure the interface board in the slot with the two screws 
included with the interface board.

7. Connect the proper interface cable to the interface board 
and to your computer. If the cable has a grounding wire, 
connect it to one of the screws securing the parallel 
interface.

Also, if you are using more than one computer, reconnect 
the other interface cable.

8. Make sure the printer is turned off. Then plug in the power 
cord.

In most cases, the printer automatically detects the interface 
you’re using. However, if you have trouble printing through an 
installed interface board, you may need to change the printer’s 
I/F (interface) mode setting. See page B-7 for instructions. 

To remove the interface board, follow the above steps in reverse 
order.
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Printing
Printing method On-demand ink jet

Nozzle configuration 128 black nozzles (32 × 4, staggered) 
64 color nozzles × 3 (cyan, magenta, yellow)

Printable columns and 
printing speed

Up to 8 pages per minute in black, 7 pages per minute in color

Technical
Specifications

Character mode

Character pitch 

(characters per inch)

Printable 

columns

Printing speed

(characters per second) 

Draft Normal

10 80 533 400

12 96 640 480

15 120 800 600

17 (10 condensed) 137 912 684

20 (12 condensed) 160 1067 800

Raster graphics mode (printable area is 8.27 inches)

Print quality Available dots

CR speed (inches per 

second) 

180 dpi  × 180 dpi 1488 26.7 

360 dpi  × 360 dpi 2976 20 

720 dpi  × 720 dpi 5952 20 

1440 dpi  × 720 dpi 5952 10 
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Resolution Maximum 1440 × 720 dpi

Input buffer 32KB

Print direction Bidirectional with logic seeking for text and graphics

Control code ESC/P 2™ and expanded raster graphics code
IBM X24E emulation code

Character tables 1 italic and 10 graphics character tables

Character sets 14 international character sets and 1 legal character set

Bitmap fonts • EPSON Roman (proportional)
• EPSON Sans Serif (proportional)
• EPSON Courier
• EPSON Prestige
• EPSON Script

All bitmap fonts are available in 10, 12, and 15 cpi. You can select 
other font/pitch combinations using ESC/P commands.

Scalable fonts • EPSON Roman
• EPSON Sans Serif
• EPSON Roman T
• EPSON Sans Serif H

All scalable fonts are available in sizes from 8 to 32 points, in 2 point 
increments, and four styles: normal, bold, italic, and bold italic.

The printer always uses the fonts you select with your software 
application. You need to use the printer’s internal fonts only if your 
application doesn’t allow you to select fonts.
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Paper

Notes:
Since the quality of any particular brand or type of paper may be changed by the manufacturer at 
any time, EPSON cannot guarantee the use of any particular brand or type of paper. Always test 
samples of paper stock before purchasing large quantities or printing large jobs.

Poor quality paper may reduce print quality and cause paper jams and other problems. If you 
encounter problems, switch to a higher grade of paper.

Do not load curled or folded paper, envelopes, or transparencies.

Print on ink jet papers and envelopes only under these conditions:
Temperature: 59 to 77°F (15 to 25°C)
Humidity: 40 to 60% RH

Store glossy media and self adhesive sheets under these conditions:
Temperature: 59 to 86°F (15 to 30°C)
Humidity: 20 to 60% RH

Paper Type Size Paper Types Thickness Weight

Single Sheets Letter (8.5 × 11 inches) 
A4 (210 × 297 mm)
A5 (148 × 210 mm)
B5 (182 × 257 mm)
Legal (8.5 × 14 inches) 
Half letter (5.5 × 8.5 inches)
Executive (7.5 × 10 inches)

Plain paper and 
special ink jet 
papers 
distributed by 
EPSON

0.003 to 0.004 inch 
(0.08 to 0.11 mm) 

17 to 24 lb 
(64 to 90 g/m2); 
use 24 lb (90 g/m2) 
paper under normal 
temperature and 
humidity conditions 

Transparencies
and glossy 
media

Letter (8.5 × 11 inches)
A4 (210 × 297 mm)
A6 (105 × 148 mm, glossy 
film only)

Transparencies, 
glossy paper, and 
glossy film 
distributed by 
EPSON

Glossy film and 
transparencies: 
0.0051 to 0.0059 
inch (0.13 to 
0.15 mm)
glossy paper:
0.0067 to 0.0071 
inch (0.17 to 
0.18 mm)

Self adhesive 
sheets 

A4 (210 × 297 mm) Self adhesive 
sheets 
distributed by 
EPSON

Envelopes No. 10 (9.5 × 4.1 inches, 
            240 × 104 mm) 
DL (8.7 × 4.3 inches, 
      220 × 110 mm) 
C6 (4.4 × 6.4 inches, 
      114 × 162 mm)

Plain, bond, or 
air mail paper

0.006 to 0.017 inch 
(0.16 to 0.43 mm)

12 to 20 lb 
(45 to 75 g/m2)

Cards A6 (105 × 148 mm)
5 × 8 inches (127 × 203 mm)
8 × 10 inches (203 × 254 mm)

Ink jet cards 
distributed by 
EPSON

0.0091 inch 
(0.23 mm)

50.7 lb (188 g/m2)
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Printable area

A The minimum top margin is 0.12 inch (3.0 mm).
When printing multiple sheets of glossy media, the minimum 
top margin is 1.2 inches (30 mm).

BL The minimum left margin is 0.12 inch (3.0 mm).

BR The minimum right margin is:
0.35 inch (9.0 mm) for Letter and Legal
0.12 inch (3.0 mm) for all other paper sizes
1.10 inches (28 mm) for #10 envelopes
0.28 inch (7 mm) for DL envelopes
0.12 inch (3 mm) for C6 envelopes

C The minimum bottom margin is 0.55 inch (14.0 mm).

Note:
Always load paper into the sheet feeder short edge first except envelopes. Load envelopes long 
edge first.

A

B-L

B-R

C

A

B-R

C

B-L

EnvelopeSingle sheet
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Ink Cartridges

* The print capacity may vary depending on how often you use the print head cleaning function. Also, if you 
print large graphics and dense text with little white space, you use ink faster.

** The ink thaws and is usable after approximately 3 hours at 77 °F (25 °C).

Caution:
To ensure good results, use genuine EPSON cartridges and do not refill them. Other 
products may cause damage to your printer not covered by EPSON’s warranty.

Do not use an ink cartridge after the expiration date on the package.

Mechanical
Paper feed method Friction with auto sheet feeder, rear entry

Sheet feeder capacity Maximum 100 sheets of 17 lb (64 g/m2) paper

Dimensions Storage
Width: 18.7 inches (475 mm) 
Depth: 10.7 inches (274 mm) 
Height: 7.4 inches (177 mm)

Printing
Width: 18.7 inches (475 mm) 
Depth: 24.0 inches (610 mm)

27.2 inches (692 mm, when loading transparencies)
Height: 12.4 inches (315 mm)

7.95 inches (202 mm, when loading transparencies)

Weight 14.3 lb (6.5 kg) without the ink cartridges

Specification Black ink cartridge (S020108) Color ink cartridge (S020089)

Color(s) Black Cyan, magenta, and yellow

Print Capacity* 900 pages (A4 paper; 
text at Normal - 360 dpi; 5%) 
(ISO/IEC 10561 Letter Pattern)

300 pages (A4 paper; 
Normal - 360 dpi, 5% each color)

Cartridge life 2 years from production date and up to within 6 months after opening package at 77 °C 
(25 °F)

Storage 

Temperature

–4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Transit 

Temperature

–22 to 140 °C (–30 to 60 °F)
1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)

Freezing 

Temperature**

–3.2 °F (–16 °C) –0.4 °F (–18 °C)

Dimensions 1.09 (W) × 2.1 (D) × 1.5 (H) inches
27.8 (W) × 52.7 (D) × 38.5 (H) mm

1.7 (W) × 2.1(D) × 1.5 (H) inches
42.9 (W) × 52.7 (D) × 38.5 (H) mm
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Electrical

Environmental
Temperature Operation 50 to 95 °F (10 to 35 °C)

Storage*  –4 to 140 °F (–20 to 60 °C)
1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)

Humidity Operation 20 to 80% RH
Storage* 5 to 85% RH 

(without condensation)

*  Stored in shipping container

Safety Approvals
Safety standards UL 1950 with D3, CSA 22.2 950 with D3

EMC FCC part 15 subpart B class B
CSA C108.8 class B

DOS Support
If driver support for the EPSON Stylus COLOR 800 is not available 
from your software manufacturer, you can use one of the other 
EPSON ESC/P 2 printer drivers. Choose the first printer available 
from the following two lists:

Black printing only • LQ-870/1170
• LQ-570(+)/1070(+)
• SQ-870/1070
• LQ-850
• LQ-500

Color and black 
printing

• EPSON Stylus PRO
• EPSON Stylus COLOR 500
• EPSON Stylus COLOR II
• LQ-860
• LQ-2550

Specification 120 V model 240 V model

Input voltage range 103.5 to 132 V 198 to 264 V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.4A 0.2A

Power consumption Approx. 18 W (ISO/IEC 10561 Letter Pattern)
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Control Panel Settings
You can change the following “default” settings from the printer’s 
control panel:

Changing control 
panel settings

Follow these steps to change the settings listed above:

1. Make sure the printer is turned off and has paper loaded.

2. Hold down the X color cleaning button and press the power 
button. The printer prints a summary of instructions for 
changing settings and choosing the language to use for additional 
instructions.

3. Press the X color cleaning button to print a list of current settings 
and additional instructions.

4. After you make the changes you want, turn the printer off to save 
the settings. The settings remain in effect until you change them 
again.

Setting Options

Print direction Auto, Bi-D, Uni-D

Font Courier, Roman, Sans Serif, Prestige, 
Script, Roman T, Sans Serif H, Draft

Pitch 10 cpi, 12 cpi, 15 cpi, 17.1 cpi, 20 cpi, 
Proportional

I/F mode Auto, Parallel, Serial, Option

Auto I/F wait time 10 seconds, 30 seconds

Software ESC/P 2, IBM X24E

Auto CR (IBM mode only) Off, On

AGM (IBM mode only) Off, On

Character table PC437, PC850, PC860, PC861, PC863, 
PC865, Abicomp, BRASCII, Roman 8, ISO 
Latin 1, Italic U.S.A., Italic France, Italic 
Germany, Italic U.K., Italic Denmark 1, 
Italic Sweden, Italic Italy, Italic Spain 1

Auto line feed Off, On

Network I/F mode Off, On

Loading position 8.5 mm, 3 mm, Others

Economy Off, On

Parallel I/F transfer rate Fast, Normal
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Control Codes 
ESC/P 2 control codes See the ESC/P® Reference Manual for more information about these 

commands.

General operation:
ESC@, ESC U, ESC EM

Paper feeding:
CR, FF, LF, ESC 0, ESC 2, ESC 3, ESC +

Page format:
ESC ( C, ESC C, ESC C 0, ESC Q, ESC l, ESC ( c, ESC N, ESC O

Print position motion:
ESC $, ESC \, ESC ( V, ESC ( v, ESC D, HT, ESC B, ESC J, VT

Font selection:
ESC k, ESC x, ESC X, ESC P, ESC M, ESC g, ESC p, ESC 4, ESC 5, 
ESC E, ESC F, ESC !

Font enhancement:
ESC W, DC 4, SO, DC2, SI, ESC w, ESC G, ESC H, ESC T, 
ESC S, ESC -, ESC ( -, ESC q

Spacing:
ESC Space, ESC c, ESC ( U

Character handling:
ESC t, ESC ( t, ESC R, ESC %, ESC &, ESC :, ESC 6, ESC 7, 
ESC ( ^ 

Bit image: 
ESC *

Graphics: 
ESC ( G, ESC ., ESC ( i, ESC ( e, ESC ( \, ESC ( s

Color:
ESC r, ESC ( r

Printing mode:
ESC ( K

IBM X24E emulation 
control codes

This printer emulates the IBM Proprinter with the following 
commands. For detailed information, see IBM’s X24E reference 
manual.

General operation:
NUL, DC3, ESC j, BEL, CAN, DC1, ESC Q, ESC [ K, ESC U

Paper feeding:
FF, LF, ESC 5, ESC A, ESC A (AGM*), ESC 0, ESC 1, ESC 2, 
ESC 3, ESC 3 (AGM*), CR

Page format:
ESC C, ESC X, ESC N, ESC O, ESC 4
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Print position motion:
ESC d, ESC R, ESC D, HT, ESC B, VT, ESC J, ESC J (AGM*)

Font selection:
DC2, ESC P, ESC :, ESC E, ESC F, ESC I

Font enhancement:
DC4, SO, ESC SO, ESC W, ESC [ @, SI, ESC SI, ESC G, ESC H, 
ESC T, ESC S, ESC -, ESC _

Spacing:
BS, SP, ESC [ \

Character handling:
ESC 6, ESC 7, ESC [ T, ESC ^, ESC \

Bit image:
ESC K, ESC L, ESC Y, ESC Z, ESC [ g, ESC * (AGM*)

* Alternate Graphics Mode

Character Tables
All character tables except Italic are the same as the PC437 table for 
hex codes 00 through 7F. Additional characters are available for hex 
codes 80 through FF. You can select the following character tables 
through the control panel or software commands:

• PC 437 (U.S./Standard Europe)
• PC850 (Multilingual)
• PC860 (Portuguese)
• PC861 (Icelandic)
• PC863 (Canadian-French)
• PC865 (Nordic)
• Abicomp
• BRASCII
• Roman 8
• ISO Latin 1
• Italic (no characters available for hex code 15)

International character 
sets

You can select a number of international character sets with the 
control panel or the ESC R command. Other sets can only be selected 
with the ESC R command. You can select additional characters with 
the ESC ( ^ command.
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Glossary

banding The horizontal lines that sometimes appear in a printed image. 
See also MicroWeave.

buffer The portion of the printer’s memory used to store data before 
printing it.

character table A collection of letters, numbers, and symbols that provides you 
with the characters used in a particular language.

characters per inch (cpi) A measure of the size of text characters, sometimes referred to as 
pitch.

CMYK Cyan (blue-green), magenta, yellow, and black. These colored 
inks are used to create printed colors.

ColorSync Macintosh software that is designed to help you get WYSIWIG 
(what you see is what you get) output. This software prints 
colors as you see them on your screen.

default A value or setting that takes effect when the equipment is 
turned on, reset, or initialized.

dithering A halftoning method in which dots are arranged in an orderly 
pattern. Dithering works best for printing images with solid 
colors, such as charts and graphs. See also halftoning.

dpi Dots per inch. The dpi measures the resolution (print quality). 
See also resolution.

driver A software program that sends instructions to a computer 
peripheral to tell it what to do. For example, your printer driver 
accepts print data from your word processing application and 
sends instructions to the printer on how to print this data.
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error diffusion This halftoning setting smooths out edges by randomly placing 
dots of varying colors. This has the opposite effect of the Finest 
Detail setting.

ESC/P Abbreviation for Epson Standard Code for Printers. This 
system of commands gives you control of your printer from 
your computer. It is standard for all EPSON printers and 
supported by most application programs for personal 
computers.

ESC/P 2 The enhanced version of the ESC/P printer command 
language. Commands in this language produce laser-like 
features, such as scalable fonts and enhanced graphics printing.

finest detail This setting automatically makes your printed images sharper 
and clearer. It has the opposite effect of the Error Diffusion 
setting. Be aware that this may increase the time required for 
printing.

font A style of print designated by a name.

grayscale Shades of gray ranging from black to white. Grayscale is used to 
represent colors when you print with black ink only.

halftoning A method of using dot patterns to represent an image. 
Halftoning makes it possible to produce varying shades of gray 
using only black dots, or a nearly infinite array of colors using 
only a few colors of dots.

initialization Returns the printer to its defaults. This happens every time you 
turn on or reset the printer.

ink jet A method of printing in which each letter or symbol is formed 
by precisely spraying ink onto paper.

interface The connection between the computer and a peripheral such as 
a printer. Generally, printers have two interfaces, parallel and 
serial. A parallel interface transmits data one byte, or eight bits, 
at a time. A serial interface transmits data one bit at a time.

IPS Inches per second. This scale is used to measure the print head 
speed.
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media Materials upon which data is printed, such as envelopes, plain 
paper, special paper, and transparency film.

MicroWeave Printing technology that produces images in fine increments to 
reduce the possibility of banding. See also banding.

parallel interface See interface.

print queue Print jobs that are sent to the printer while it is busy are stored 
in a waiting line, or print queue, until they can be printed.

printable area The area of a page on which the printer can print. It is smaller 
than the physical size of the page because of margins.

printer driver See driver.

proportional printing Printing in which the width of the character varies from 
character to character. For example, a capital W receives much 
more space than a lowercase i.

reset To return a printer to its defaults either by sending a command, 
an INIT signal, or by turning the printer off and then back on.

resolution The number of dots per inch used to represent an image. The 
higher the resolution or print quality, the more detailed and 
realistic the image.

scalable fonts Fonts that can be enlarged or reduced. Non-scalable fonts 
(bitmap fonts) can’t change in size.

screen pattern This feature prints shaded areas as they appear on screen, 
instead of printing them as halftones.

serial interface See interface.

spool manager A software program that converts print data into codes that 
your printer understands. 

status monitor A software program that allows you to check the printer’s status, 
such as the amount of ink remaining before printing.
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Index

A Advanced mode, selecting, 
3-1 to 3-3

Advanced settings
custom, 3-4 to 3-11
dialog box, 3-4 to 3-9
predefined, 3-1 to 3-3

Aligning print heads, 5-8 to 5-9, 
6-5

AppleTalk, 4-13
Assigning name to printer, 4-12
Automatic mode, 1-2, 1-7

B Background printing, 4-6 to 4-7, 
4-13

Banding, 6-5
Banners

loading paper, 2-6
printing from Macintosh, 

2-8 to 2-10
printing from Windows, 

2-7 to 2-8
Blank pages, 6-16
Blurry printouts, 6-7
Brightness setting, 3-8

C Cards, 2-2, 2-5, B-3
Character tables, B-9
Characters, garbled, 6-15
Cleaning print heads

using control panel, 5-7 to 5-8
using Head Cleaning utility, 

5-6 to 5-7
Cleaning printer, 5-10
Cleaning sheets, 2-3
Color Adjustment modes, 3-8
Color problems, 6-5 to 6-6
ColorSync, using, 3-9 to 3-10
CompuServe, 6

Configuration button, 4-9
Contrast setting, 3-8
Control codes, B-8 to B-9
Control panel default settings, B-7
Control panel, using, 1-8, 

5-7 to 5-9, 6-2
Current settings list, 1-2, 1-6
Custom settings

color, 3-7 to 3-11
list, 3-3
print quality, 3-4 to 3-6
saving, 3-11
special effects, 3-4 to 3-6

Custom size paper, 2-6 to 2-10
Cyan setting, 3-8

D Default control panel settings, B-7
Default printer options, setting, 

1-4
Deleting print job, 4-3
Despooler, 1-5, 4-5, 6-11
Dithering, 3-6
DOS support, B-6
Driver, 1-1, 1-6

E Economy setting, 3-3
Electrical specifications, B-6
ENERGY STAR, 6
Energy-saving tips, 7
Envelopes

loading, 2-4 to 2-5
specifications, B-3 to B-4

Environmental specifications, B-6
EPSON

Accessories, 5, 2-2
Customer Care Centers, 4
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EPSON (continued)
Electronic Support Services, 

5 to 6
help, 4 to 6
media, 2-1 to 2-2
World Wide Web site, 5

EPSON Namer utility, 4-12
EPSON Spool Manager, see Spool 

Manager
Error Diffusion setting, 3-6
Error notification, 4-9
ESC/P 2 control codes, B-8
Ethernet board, A-2

F Faint printouts, 6-6
Film, see Photo Quality glossy 

media
Finest Detail setting, 3-6
Flip Horizontal setting, 3-6, 6-15
Fonts, B-2
Forms, loading, 2-3

G Garbled characters, 6-15
Glossy media, 2-2 to 2-4, 

B-3 to B-4

H Halftoning setting, 3-6
Head Cleaning utility, 5-6 to 5-7
Help, 4 to 6
Help, online, 1-2
Hex dump mode, 6-3 to 6-4
High Speed setting, 3-6
Horizontal banding, 6-5
Host system, network setup, 4-10

I IBM X24E emulation control 
codes, B-8 to B-9

ICM (Image Color Matching) 
setting, 3-9

Ink
cartridge specifications, B-5
replacing cartridges, 5-1 to 5-5
replacing outdated cartridge, 

5-5
smears, 2-5
specifications, B-5
supply, 1-5, 1-8, 4-8

Ink Jet Cards, see Photo Quality 
Ink Jet Cards

Ink Jet Paper
loading, 2-3
settings, 2-2
specifications, B-3 to B-4

Interface boards
installing, A-3 to A-4
Macintosh, A-2
removing, A-4
selecting, A-1
serial, A-2

International character sets, B-9
Internet, 5
Iron-On Transfer Paper, 2-2, 2-6, 

B-3 to B-4

J Jammed paper, 1-8, 6-14
Journal files, 4-2, 4-9 to 4-12

L Letterhead, see Paper
Lights, using, 1-8, 6-1 to 6-2
LocalTalk board, A-2

M Macintosh
ColorSync, 3-9 to 3-10
increasing memory allocation, 

4-7
interface boards, A-2
managing print jobs, 4-6 to 4-9
Monitor2, 4-6 to 4-7
network printing, 4-12 to 4-13
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Macintosh (continued)
printing from, 1-6 to 1-7, 

2-8 to 2-10
problems printing, 6-11 to 6-12
Status Monitor, 4-8 to 4-9

Magenta setting, 3-8
Main printer settings dialog box, 

1-2
Maintaining printer, 5-1 to 5-10
Manual, how to use, 3 to 4
Margin problems, 6-15
Margin, with multiple sheets, 2-4
Mechanical specifications, B-5
Media Type setting, 1-3, 1-7, 2-2
Memory allocation, increasing on 

Macintosh, 4-7
MicroWeave setting, 3-6
Monitor2, 4-6 to 4-7
More Settings dialog box, 

3-4 to 3-10

N Namer utility, EPSON, 4-12
Network path, Windows 95, 

4-11 to 4-12
Network printing

Macintosh, 4-12 to 4-13
PC, 4-9 to 4-12

Nozzle Check, 5-8

P Packing printer, 5-11
Page Setup, 1-6, 2-9
Pages per minute, 1, B-1
Paper

custom size, 2-6 to 2-10
dialog box, 2-7, 2-9
handling problems, 

6-13 to 6-14
loading, 2-3, 2-6
ordering, 2-2
plain, 1-3
specifications, B-3 to B-4
supply, 1-8
tab, 2-7

Paper jams, 1-8, 6-14
Paper support, 2-4

Paper tab, 1-3
Paper thickness lever, 2-5
Photo Quality glossy media

choosing, 1-7, 2-2
loading, 2-3 to 2-4
specifications, B-3 to B-4

Photo Quality Ink Jet Cards, 2-2, 
2-5, B-3

Photo Quality Ink Jet Paper, 2-2, 
B-3 to B-4

Photo Quality Self Adhesive 
Sheets, 2-2, 2-5, B-3

Photo setting, 3-3
Plain paper, 1-3, B-3 to B-4
Preprinted forms, loading, 2-3
Print Head Alignment utility, 

5-8 to 5-9, 6-5
Print heads, cleaning, see Cleaning 

print heads
Print jobs

deleting, 4-3
managing in Windows, 

4-1 to 4-6
managing on Macintosh, 

4-6 to 4-9
Print quality

customizing, 3-4 to 3-6
problems, 6-4 to 6-7

Print queues, 4-2 to 4-4
Print speed, B-1
Printer driver, 1-1, 1-6
Problems

diagnosing, 6-1 to 6-4
paper handling, 6-13 to 6-14
photographs, 6-7
print quality, 6-4 to 6-7
printing, 6-8 to 6-12
slow printing, 6-12
solving, 6-1 to 6-16
Status Monitor, 6-11
unexpected printout results, 

6-15 to 6-16

Q Quality/Speed slider, 1-3, 1-7
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R Remote systems, network setup, 
4-10 to 4-11

Rendering Intent setting, 3-10
Replacing ink cartridges, 5-1 to 5-5
Resolution, 1, 3-5, see also Print 

quality

S Safety approvals, B-6
Safety instructions, 7 to 8
Saturation setting, 3-8
Self Adhesive Sheets, 2-2, 2-5, B-3
Self test, 6-3
Serial interface board, A-2
Service, 4 to 6
Settings

checking, 1-2 to 1-3, 1-6 to 1-7
default, 1-4
reusing on Macintosh, 1-7

Slow printing, 6-12
Smears, 2-5
Special Coated Paper, 2-2
Special effects, 3-4 to 3-6
Specifications

character tables, B-9
control codes, B-8 to B-9
control panel settings, B-7
DOS support, B-6
electrical, B-6
environmental, B-6
ink cartridges, B-5
mechanical, B-5
paper, B-3 to B-4
printing, B-1 to B-2
safety approvals, B-6

Speed, printing, B-1
Spool directory, changing default, 

4-3 to 4-4
Spool Manager

deleting print job, 4-3
problems, 6-9, 6-11, 6-15
using, 4-1 to 4-4

Status Monitor
enabling, 4-6
Macintosh, 4-8 to 4-9
problems, 6-11
using, 4-4 to 4-6
Windows 95, 1-5, 4-4 to 4-6

Support, 4 to 6
System requirements, 2

T Technical specifications, 
B-1 to B-9

Testing printer, 6-3
Text/Graph setting, 3-3
Thickness lever, 2-5
Transparencies

choosing, 1-3, 1-7, 2-2
loading, 2-3 to 2-4
specifications, B-3

Transporting printer, 5-11
Troubleshooting, 6-1 to 6-16

V Video/Digital Camera setting, 3-3, 
3-9

W Warnings, 4-9
Windows

managing print jobs, 4-1 to 4-6
printing from, 1-1 to 1-5, 

2-7 to 2-8
Spool Manager, 4-1 to 4-4

Windows 95
network printing, 4-9 to 4-12
problems, 6-10 to 6-11
Status Monitor, 1-5, 4-4 to 4-6

Windows NT, 1-1
World Wide Web, 5

Y Yellow setting, 3-8

easter.ix  Page 4  Tuesday, January 14, 1997  9:58 AM


	FRONT MATTER
	CONTENTS
	INTRODUCTION
	Windows System Requirements
	Macintosh System Requirements
	How To Use Your Manuals
	Warnings, Cautions, and Notes

	Where To Get Help
	Electronic Support Services

	ENERGY STAR Compliance
	Energy-saving Tips

	Important Safety Instructions

	CHAP 1-BASIC PRINTING
	Printing from Windows
	Setting Printer Options from Windows Applications
	Setting Default Printer Options
	Checking Printer Status

	Printing from a Macintosh
	What To Do When the Printer Lights Flash

	CHAP 2-PRINTING ON SPECIAL MEDIA
	Using Special Paper and Media
	Letterhead, Preprinted Forms, and Legal-size Paper
	EPSON 360 dpi High Quality and Photo Quality Ink Jet Paper
	EPSON Photo Quality Glossy Paper, Film, and Transparencies
	Envelopes
	EPSON Photo Quality Ink Jet Cards
	EPSON Photo Quality Self Adhesive Sheets
	EPSON Iron-On Transfer Paper

	Printing Banners and Other Custom Size Projects
	Printing a Banner from Windows
	Printing a Banner from a Macintosh


	CHAP 3-CUSTOM PRINTING
	Using Predefined Advanced Settings
	Customizing Print Quality and Special Effects
	Customizing Color Settings
	Using ColorSync on the Macintosh
	Saving Custom Settings

	CHAP 4-MANAGING PRINT JOBS AND NETWORK PRINTING
	Managing Print Jobs in Windows
	Using the Spool Manager
	Using the Status Monitor

	Managing Print Jobs on a Macintosh
	Using Monitor2
	Using the Macintosh Status Monitor

	Network Printing on a PC
	Setting Up the Host System
	Setting Up Remote Systems
	Setting Up Your Network Path in Windows 95

	Network Printing on a Macintosh
	Assigning a Name to the Printer
	Using the AppleTalk Connection


	CHAP 5-MAINTENANCE AND TRANSPORTATION
	Replacing an Ink Cartridge
	Removing an Empty Ink Cartridge
	Installing the New Cartridge
	Replacing an Outdated Ink Cartridge

	Cleaning the Print Heads
	Using the Head Cleaning Utility
	Using the Control Panel To Clean the Print Heads
	Examining the Nozzle Check Pattern

	Aligning the Print Heads
	Using the Print Head Alignment Utility
	Using the Control Panel To Align the Print Heads

	Cleaning the Printer
	Transporting the Printer

	CHAP 6-TROUBLESHOOTING
	Diagnosing Problems
	Reading the Control Panel Lights
	Running a Self Test
	Using Hex Dump Mode

	Improving Print Quality
	Printed Image has Horizontal Banding.
	Vertical Lines are Misaligned or Vertical Banding Appears.
	The Printed Image has Incorrect or Missing Colors.
	The Printed Image is Faint or has Gaps.
	The Printed Image is Blurry or Smeared.
	Photographic Images Look Grainy or Rough.

	Solving Printing Problems
	All Lights are Off.
	Only the Light is On, but Nothing Prints.
	The Paper Out Light is Flashing or On.
	A Black or Color Ink Out Light is Flashing or On.
	The Paper out and Power Lights are Flashing.
	All the Lights are Flashing.
	The Printer has Finished Charging the Ink Cartridge, but the Power Light is Still Flashing.
	The Printer Software Installed with Windows 3.1 Doesn’t Work Correctly After you Upgrade to Windows 95.
	After you Install your Printing Software, you See the Windows 95 New Hardware Found Window.
	You See a Spooling Error Message (Windows).
	You See a Memory Error Message (Macintosh).
	In Windows 95, the Status Monitor Box does not Appear with the Despooler.
	A portion of your Image Doesn’t Print (Macintosh).
	Printing is Too Slow.
	Your Printer Switches to the Modem Port or Won’t Confirm on the Printer Port (Macintosh).
	Your Printer Icon Doesn’t Appear in the Chooser (Macintosh).

	Fixing Paper Problems
	Paper Desn’t Feed.
	Multiple Pages Feed at the Same Time.
	Paper Jams Inside the Printer.
	Paper Doesn't Eject Fully or is Wrinkled.

	Solving Miscellaneous Printout Problems
	Characters are Incorrect or Garbled.
	The Margins are Incorrect.
	The Image is Inverted as if Viewed in a Mirror.
	The Printer Prints Blank Pages.


	APPENDIX A-USING OPTIONAL INTERFACES
	Selecting an Interface Board
	Using Macintosh Interface Boards
	Using the PC Serial Interface Board
	Installing Optional Interfaces

	APPENDIX B-TECHNICAL SPECIFICATIONS
	Printing
	Paper
	Ink Cartridges
	Mechanical
	Electrical
	Environmental
	Safety Approvals
	DOS Support
	Control Panel Settings
	Control Codes
	Character Tables

	GLOSSARY
	INDEX



